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Application Scenarios

APIG involves the following development scenarios:

e API calling authentication: For APIs that use app or IAM authentication, API
calling authentication should be developed for the service system to add
authentication information to API requests.

- API calling through app authentication (signature authentication):
API callers provide a key, secret, and SDK through APIG to complete
signature authentication for their API requests.

- API calling through IAM authentication (token authentication): API
callers obtain a token from the cloud service platform and add the token
to their API requests.

- API calling through IAM authentication (AK/SK authentication): API
callers sign their API requests using AK (Access Key ID) /SK (Secret Access
Key) and SDKs provided by APIG.

e Signature verification by backend service: If an APl is bound with a
signature key on APIG, the request sent by APIG to the backend service of the
API carries the corresponding signature information. The backend service of
the APl must integrate the SDK provided by APIG and verify the signature
information in the request.

e APl import and export: When importing APIs in APIG, extended definitions
need to be supplemented for the API definition file.

2025-02-21 1
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Calling APIs Through App
Authentication

2.1 Preparation

Before calling APIs in app authentication mode, complete the following
operations:

Obtain API request information

On the APIG console, choose API Publishing > APIs, and click an APl name to
go to the details page. Choose API Call > API Request, and view the domain
name, request path, and request method.

Publish APIs in an environment

On the APIG console, choose API Publishing > APIs, and click an APl name to
go to the details page. Choose API Call > API Request, and view the
environment in which the API has been published.

Obtain APl authentication information

To sign an API request cryptographically through app authentication
(signature authentication), the AppKey and AppSecret of an app authorized
to call the API are required. On the APIG console, choose API Calling > Apps.
Go to the details page of an app, and obtain the AppKey and AppSecret.

(11 NOTE

e AppKey or Key: access key ID of an app. It is the unique ID associated with a secret
access key. The access key ID and secret access key are together used to obtain an
encrypted signature for a request.

e AppSecret or Secret: secret access key used together with an access key ID to sign
requests. The access key ID and secret access key can be together used to identify
a request sender to prevent the request from being modified.

When sending an API request, add the current time to the X-Sdk-Date header
and the signature information to the Authorization header.
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NOTICE

e The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

e APIG checks the time format and compares the time with the time when
APIG receives the request. If the time difference exceeds 15 minutes, APIG
will reject the request.

2.2 App Authentication

Constraints

1. Construct a standard request.

Assemble the request content according to the rules of APIG (API
Management), ensuring that the client signature is consistent with that in the
backend request.

2. Create a to-be-signed string using the standard request and other related
information.

3. Calculate a signature using the AK/SK and to-be-signed string.

4. Add the generated signature to an HTTP request as a header or query
parameter.

5. After receiving the request, APIG performs 1 to 3 to calculate a signature.

6. The new signature is compared with the signature generated in 3. If they are
consistent, the request is processed; otherwise, the request is rejected.

The body of a signing request in app authentication mode cannot exceed 12 MB.

Step 1: Constructing a Standard Request

To access an API through app authentication, standardize the request content, and
then sign the request. The client must follow the same request specifications as
APIG so that each HTTP request can obtain the same signing result from the
frontend and backend to complete identity authentication.

The pseudocode of standard HTTP requests is as follows:

CanonicalRequest =
HTTPRequestMethod + '\n' +
CanonicalURI + '\n' +
CanonicalQueryString + '\n' +
CanonicalHeaders + '\n' +
SignedHeaders + '\n' +
HexEncode(Hash(RequestPayload))

The following example shows how to construct a standard request.

Original request:

GET https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?b=2&a=1 HTTP/1.1

Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com

X-Sdk-Date: 20191111T093443Z

1. Specify an HTTP request method (HTTPRequestMethod) and end with a
carriage return line feed (CRLF).
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For example:
GET

Add a standard URI (CanonicalURI) and end with a CRLF.

Description

Path of the requested resource, which is the URI code of the absolute path.
Format

According to RFC 3986, each part of a standard URI except the redundant and
relative paths must be URI-encoded. If a URI does not end with a slash (/),
add a slash at its end.

Example

For the URI /app1, the standard URI code is as follows:

GET
/app1/

A URI must end with a slash (/) for signature calculation. However, the
slash is not required when a request is sent.

Add a standard query string (CanonicalQueryString) and end with a CRLF.
Description

Query parameters. If no query parameters are configured, the query string is
an empty string.

Format

Standard query strings must meet the following requirements:

- Perform URI encoding on each parameter and value according to the
following rules:

® Do not perform URI encoding on any non-reserved characters
defined in RFC 3986, including A-Z, a-z, 0-9, hyphen (-), underscore
(1), period (.), and tilde (~).

"  Use %XY to perform percent encoding on all non-reserved
characters. X and Y indicate hexadecimal characters (0-9 and A-F).
For example, the space character must be encoded as %20, and an
extended UTF-8 character must be encoded in the "%XY%ZA%BC"
format.

- Add "URI-encoded parameter name = UR/-encoded parameter value" to
each parameter. If no value is specified, use a null string instead. The
equal sign (=) is required.

For example, in the following string that contains two parameters, the
value of parameter parm2 is null.
parmi=valuel&parm2=

- Sort the parameters in alphabetically ascending order. For example, a
parameter starting with uppercase letter F precedes another parameter
starting with lowercase letter b.

- Construct standard query strings from the first parameter after sorting.

Example

The following example contains two optional parameters a and b.

GET

/app1/
a=1&b=2
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4. Add standard headers (CanonicalHeaders) and end with a CRLF.
Description

List of standard request headers, including all HTTP message headers in the
to-be-signed request. The X-Sdk-Date header must be included to verify the
signing time, which is in the UTC time format YYYYMMDDTHHMMSSZ as
specified in ISO 8601. When publishing an API in a non-RELEASE
environment, you need to specify an environment name.

NOTICE

e The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

e APIG checks the time format and compares the time with the time when
APIG receives the request. If the time difference exceeds 15 minutes, APIG
will reject the request.

Format

CanonicalHeaders consists of multiple message headers, for example,
CanonicalHeadersEntry0 + CanonicalHeadersEntry1 + .... Each message
header (CanonicalHeadersEntry) is in the format of
Lowercase(HeaderName) + "' + Trimall(HeaderValue) + '\n'.

- Lowercase: a function for converting all letters into lowercase letters.
- Trimall: a function for deleting the spaces before and after a value.

- The last message header carries a CRLF. Therefore, an empty line appears
because the CanonicalHeaders field also contains a CRLF according to
the specifications.

- The message header name must be unique. Otherwise, authentication
fails.

Example

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z
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NOTICE

Standard message headers must meet the following requirements:

e All letters in a header are converted to lowercase letters, and all spaces
before and after the header are deleted.

e All headers are sorted in alphabetically ascending order.

For example, the original headers are as follows:

Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
Content-Type: application/json;charset=utf8\n

My-header1: a b c \n

X-Sdk-Date:20191111T093443Z\n

My-Header2: "a b c" \n

A standard header is as follows:

content-type:application/json;charset=utf8\n
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
my-headerl:a b c\n

my-header2:"a b c"\n

x-sdk-date:20191111T7093443Z\n

Add message headers (SignedHeaders) for request signing, and end with a
CRLF.

Description

List of message headers used for request signing. This step is to determine
which headers are used for signing the request and which headers can be
ignored during request verification. The X-Sdk-date header must be included.

Format

SignedHeaders = Lowercase(HeaderNameO0) + ';' + Lowercase(HeaderName1)
+ n.n + .

7

Letters in the message headers are converted to lowercase letters. All headers
are sorted alphabetically and separated with commas.

Lowercase is a function for converting all letters into lowercase letters.
Example

In the following example, two message headers host and x-sdk-date are used
for signing the request.

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date

Use the hash function SHA-256 to create a hash value based on the body
(RequestPayload) of the HTTP or HTTPS request.

Description

Request message body. The message body needs two layers of conversion
(HexEncode(Hash(RequestPayload))). Hash is a function for generating
message digest. Currently, SHA-256 is supported. HexEncode: the Base16
encoding function for returning a digest consisting of lowercase letters. For
example, HexEncode ("m") returns 6d instead of 6D. Each byte you enter is
expressed as two hexadecimal characters.

If RequestPayload is null, the null value is used for calculating a hash
value.
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Example

This example uses GET as an example and leaves the request body empty.
After hash processing, the request body (empty string) is as follows:

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

7. Perform hash processing on the standard request in the same way as that on
the RequestPayload. After hash processing, the standard request is expressed
with lowercase hexadecimal strings.

Algorithm pseudocode:
Lowercase(HexEncode(Hash.SHA256(CanonicalRequest)))

Example of standard request after hash processing:
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155¢c0

Step 2: Creating a To-Be-Signed String

After a standard HTTP request is constructed and the request hash value is
obtained, create a to-be-signed string by combining them with the signature
algorithm and signing time.
StringToSign =

Algorithm + \n +

RequestDateTime + \n +
HashedCanonicalRequest

Parameters in the pseudocode are described as follows:

e Algorithm
Signature algorithm. For SHA256, the value is SDK-HMAC-SHA256.
e RequestDateTime

Request timestamp, which is the same as X-Sdk-Date in the request header.
The format is YYYYMMDDTHHMMSSZ.

e HashedCanonicalRequest

Standard request generated after hash processing.
In this example, the following to-be-signed string is obtained:
SDK-HMAC-SHA256

20191111T093443Z
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155c0

Step 3: Calculating the Signature

Use the AppSecret and created character string as the input of the encryption
hash function, and convert the calculated binary signature into a hexadecimal
expression.

The pseudocode is as follows:

signature = HexEncode (HMAC(APP secret, string to sign))
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HMAC indicates hash calculation, and HexEncode indicates hexadecimal
conversion. Table 2-1 describes the parameters in the pseudocode.

Table 2-1 Parameter description

Parameter Description

AppSecret Signature key.

To-be-signed string | Character string to be signed.

If the AppSecret is FWTh5tqu2Pb9ZGt8NI09XYZti2V1LTa8useKXMDS, the
calculated signature is as follows:

01cc37e53d821da93bb7239c5b6e1640b184a748f8c20e61987b491e00b15822

Step 4: Adding the Signature to the Request Header

2.3 Java

Add the signature to the HTTP Authorization header. The Authorization header is
used for identity authentication and not included in the signed headers.

The pseudocode is as follows:

Authorization header creation pseudocode:
Authorization: algorithm Access=APP key, SignedHeaders=SignedHeaders, Signature=signature

There is no comma before the algorithm and Access. SignedHeaders and
Signature must be separated with commas.

The signed headers are as follows:

Authorization: SDK-HMAC-SHA256 Access=FMORLCN****+++++xNAX|SK, SignedHeaders=host;x-sdk-date,
Signature=01cc37e53d***e00b15822

The signed headers are added to the HTTP request for identity authentication. If
the identity authentication is successful, the request is sent to the corresponding
backend service for processing.

Scenarios
To use Java to call an API through app authentication, obtain the Java SDK, create
a project or import an existing project, and then call the API by referring to the
API calling example.
This section uses Eclipse 4.5.2 as an example.

2025-02-21 8
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Figure 2-1 API calling process
Start

L
Obtain the SDK.

l

¥
Create a project. IR T Y]
project.

¥
Call the APL.

L]
End

Prerequisites
e You have obtained API calling information. For details, see Preparation.

e You have installed Eclipse 3.6.0 or a later version. If not, download Eclipse
from the official Eclipse website and install it.

e You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it. IDK 17 or
later is not supported.

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Then obtain the ApiGateway-java-sdk.zip package. The following table shows
the files decompressed from the package.

Name Description

libs\ SDK dependencies
libs\java-sdk-core-x.x.xjar SDK package
src\com\apig\sdk\demo\Main.java Sample code for signing requests

src\com\apig\sdk\demo\OkHttpDemo.java

src\com\apig\sdk\demo\LargeFileUpload-
Demo.java

.classpath Java project configuration files

.project

2025-02-21 9
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Importing a Project
Step 1 Open Eclipse and choose File > Import.

The Import dialog box is displayed.

Step 2 Choose General > Existing Projects into Workspace and click Next.

The Import Projects dialog box is displayed.

Figure 2-2 Importing a project

& Import

Select

Create new projects from an archive file or directory,

Select an import source:

type filter text

o [ e
(L]

4 (= General
JE Archive File
|[ﬁ Existing Projects into Waorkspace

[, File System

[} Preferences
> = Git
= Gradle

m

. - —
":?/' = Back Mext = Finish

Step 3 Click Browse and select the directory where the SDK is decompressed.

2025-02-21
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Figure 2-3 Selecting the demo project

S Import = &=
Import Projects E f
-

Select a directory to search for existing Eclipse projects.

@ Select root directory: | DtYjava©\ApiGateway-java-sdk- - Browse... l
() Select archive file: Browse...
Projects:

java-sdk-demo (D¥\java\ApiGateway-java-sdhk- I Select All

Deselect All

Refresh

i

Options
[[] Search for nested projects
[ Copy projects into workspace
[[|Hide projects that already exist in the workspace
Working sets
[[] Add project to working sets

Select...

'i?::' Mext = Finish ] ’ Cancel

Step 4 Click Finish.

Modify the parameters in sample code Main.java as required. For details about
the sample code, see API Calling Example.

--—-End

Creating a Project
Step 1 Open Eclipse and choose File > New > Java Project.
The New Java Project dialog box is displayed.

Step 2 Enter a project name, for example, java-sdk-demo, retain the default settings for
other parameters, and click Finish.
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Figure 2-4 Creating a project

&= New Java Project = I@
Create a Java Project —
Create a Java project in the workspace or in an external location.

Project name: java-sdk-demo

Use default location

Ch\Users), \workspaceljava-sdk-demo Browse...
JRE
@ Use an execution enviranment JRE: JavaSE-1.8 -
i7) Use a project specific JRE: jrel.8.0 191
(71 Use default JRE {currently jrel.8.0 191" Configure JREs...

Project layout

71 Use project folder as root for sources and class files

@ Create separate folders for sources and class files  Configure default...

Working sets
[[] Add project to working sets

Select...

@' = Back Mext = ] [ Finish l ’ Cancel

Step 3 Import the .jar files in the APIG Java SDK.

1. Choose java-sdk-demo, right-click, and choose Build Path > Add External
Archives from the shortcut menu.
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2.

Figure 2-5 Importing the .jar files

4 |l java=dl-d '
'FLE%’ g Mew 4
b o J Go Into
Open in New Window
Dpen Type Hierarchy F
Show In Alt+Shift+W ¥
Copy Ctrl+C
EZ  Copy Qualified Name
[} Paste Cirl+V
H  Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
Build Path 1 v | Zm  Link Source...
Source Alt+Shift+S v | &9 MNew Source Folder...
Refactor Alt+Shift+T » 6B Use as Source Folder
i Import.. 2 s Add External Archives...
g Export.. =\ Add Libraries...
«5 Refresh FS | g Configure Build Path...

Select all .jar files in the \libs directory.

Figure 2-6 Selecting all .jar files

| commons-codec-1.11jar 2019/3/15 10:23  Executable Jar File 328 KB|
| =] commons-logging-1.2jar 2019/3/15 10:23 Executable Jar File 61 KB |
| =] httpclient-4.5.5.jar 2019/3/15 10:23  Executable Jar File 749 KB |
| ] httpcore-4.4.9.jar 2019/3/15 10:23  Executable Jar File 318 KB|
| =] java-sdk-core-3.0.9.jar 2019/3/15 10:23  Executable lar File 101 KB |
| 2] joda-time-2.9.9,jar 2019/3/15 10:23  Executable Jar File 620 KB |
| €] okhttp-3.11.0,jar 2019/3/15 10:23  Executable Jar File 404 KB |
| =] okio-1.15.0,ar 2019/3/15 10:23  Executable Jar File 87 KB |

Step 4 Create a package and Main file.

1. Choose src, right-click, and choose New > Package from the shortcut menu.

Figure 2-7 Creating a package
4 (= java-sdk-demo

blfﬁ—; 1 ¥ |22 Java Project
4 = R Open in New Window wi |z
b fme Open Type Hierarchy F4 2
b 'E Show In Alt+Shift+ W | & Class
E :; Copy Ctrl+C € Interface
« B B3 | Conv Oualfied Name B

2. Enter com.apig.sdk.demo for Name.
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Figure 2-8 Setting a package name

& Mew Java Package | = '@

Java Package
Create a new Java package.

Creates folders corresponding to packages.

Source folder: java-sdk-demojfsrc

Mame: com.apig.sdk.demo

[| Create package-infojava

@' Einish l ’ Cancel

3. Click Finish.
The package is created.

4. Choose com.apig.sdk.demo, right-click, and choose New > Class from the
shortcut menu.

Figure 2-9 Creating a class
4 [ java-sdk-demao

4 (B grg
E . L 1 I

- @ JRE 1 | 2% Java Project
4 m) Refe Open in New Window [ Project..

¢ fma g Open Type Hierarchy F4 | §F Package

» 59 Showln Alt+Shift+W » 2

> foig }‘

. oy H 2 Copy cirlec | G Interface

> g i B Copy Qualified Name & Enum

. s ji [ Paste Ctrl+V ® Annotation

5. Enter Main for Name and select public static void main(String[] args).
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Figure 2-10 Configuring the class

= New Java Class

5]l

]

Java Class =
Create a new Java class.
Source folder: Java-sdk-demo/src
com.apig.sdk.demo
Browse...

Package:

[[]Enclosing type:

Modifiers: @ public (") package private protected
[] abstract [ final static
Superclass: java.lang.Object
Interfaces: Add...
Eemove
Which method stubs would you like to create?
| [lipublic static void main(String[] args);
[7] Constructors from superclass
[¥] Inherited abstract methods
Do you want to add comments? (Configure templates and default value here
|:| Generate comments
[ Cancel

l

Finish

@

6. Click Finish.
The Main file is created.

Step 5 View the directory structure of the project.

15
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Figure 2-11 Directory structure of the new project Main

4 [} java-sdk-demo
4 [ src
4 B} com.apig.sdlk.demo
[ 4] Mainjavai|
- @), JRE System Library [JavaSE-1.8]

4 @), Referenced Libraries

- jms commons-codec-1.11ar - [

on commons-logging-1.2.jar -|0:

o hittpclient-4.3.5.jar - O javalAp

o httpcore-4.4.9 jar - D4 java\fipi

]

java-sdk-core-3.0.9.jar - D:|jav

=

joda-time-2.9.9 jar - D\ javd\Ar
okhttp-3.11.0jar - D\java'\4pic

s okio-1.15.0Jar - Di\java'\Ap|Ga

]

Before using Main.java, enter the required code according to the API calling
example provided in this section.

--—-End

API Calling Example
10 NOTE

e You need to create an APl with the Mock backend on the console, and then publish the
API. For details about how to create and publish an API, see the AP/ Gateway User
Guide.

e The backend of this APl is a fake HTTP service, which returns response code 200 and
message body Congratulations, sdk demo is running.

Step 1 Add the following references to Main.java:

import java.io.lOException;
import javax.net.ssl.SSLContext;

import org.apache.http.Header;

import org.apache.http.HttpEntity;

import org.apache.http.HttpResponse;

import org.apache.http.client. methods.HttpRequestBase;
import org.apache.http.conn.ssl. AllowAllHostnameVerifier;
import org.apache.http.conn.ssl.SSLConnectionSocketFactory;
import org.apache.http.conn.ssl.SSLContexts;

import org.apache.http.conn.ssl.TrustSelfSignedStrategy;
import org.apache.http.impl.client.CloseableHttpClient;
import org.apache.http.impl.client.HttpClients;

import org.apache.http.util.EntityUtils;

import com.cloud.apigateway.sdk.utils.Client;
import com.cloud.apigateway.sdk.utils.Request;

Step 2 Construct a request by configuring the following parameters:

e AppKey and AppSecret: In this example, the AK and SK stored in the
environment variables are used. Specify the environment variables
CLOUD SDK AK and CLOUD SDK SKin the local environment first. The
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Step 3

following uses Linux as an example to describe how to set the obtained
AK/SK as environment variables and fill them in the sample code.

a.

Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

Run the following command to apply the modification:
source ~/.bashrc

Method: Specify a request method. The sample code uses POST.
url: Request URL of the API, excluding the QueryString and fragment parts.

Use your own independent domain name. The sample code uses http://
€967a237-cd6¢c-470e-906f-a8655461897e.apigw.exampleRegion.com/java-
sdk.

queryString: Specify query parameters to be carried in the URL. Characters

(0-9a-zA-Z./;[1\-=~#%"&_+:") are allowed. The sample code uses
name=value.

header: Specify request headers. The sample code uses Content-Type:text/

plain. If you are going to publish the API in a non-RELEASE environment,
specify an environment name. The sample code uses x-
stage:publish_env_name.

e body: Specify the request body. The sample code uses demo.

The sample code is as follows:

Request request = new Request();
try

{

sdk");

request.setKey (System.getenv (" CLOUD_SDK_AK"));
request.setSecret(System.getenv(" CLOUD_SDK SK"));

request.setMethod("POST");

request.setUrl(" http.//c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.comy/java-

//URL
request.addQueryStringParam("name", "value");
request.addHeader (" Content-Type", "text/plain");

non

//request.addHeader (" x-stage", " publish_env_name"); //Specify an environment name before

publishing the API in a non-RELEASE environment.

request.setBody("demo");

} catch (Exception e)

{

}

e.printStackTrace();
return;

Sign the request, access the API, and print the result.

The sample code is as follows:
CloseableHttpClient client = null;
try

{

HttpRequestBase signedRequest = Client.sign(request);

client = HttpClients.custom().build();

HttpResponse response = client.execute(signedRequest);
System.out.println(response.getStatusLine().toString());
Header[] resHeaders = response.getAllHeaders();

for (Header h : resHeaders)

2025-02-21
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Step 4 Choose Main.java, right-click, and choose Run As > Java Application to run the

{
}

System.out.println(h.getName() + ":" + h.getValue());

HttpEntity resEntity = response.getEntity();

if (resEntity != null)

System.out.println(System.getProperty("line.separator") + EntityUtils.toString(resEntity, "UTF-8"));

}

} catch (Exception e)

{
e.printStackTrace();

} finally
{
try

if (client != null)
client.close();

}
} catch (IOException e)
{

}
}

e.printStackTrace();

project test code.

Figure 2-12 Running the project test code

4 [ java-sdk-demo
> m), JRE System Library [jre1.8.0_191]
4 (B src
4 i com.apig.sdk.demo
> ) LargeFileUploadDema java
> |4 My
> [1) Ok

> @i Referenc

New

Open
» (= libs Open With
2/ changelg Open Type Hierarchy

Show In

B Copy
52 Copy Qualified Name
Paste

H Delete

Remaove from Context
Build Path
Source

Refactor

g  Import.
0y  Export.

References

Declarations

" Refresh

Assign Working Sets...

Debug As

Vialidas~

IRV I TR

PN
TR

pusnage

L T

/{Import the external dependencies.

public class Main {

F3

F4
Alt+Shift+W

Ctrl+C

Ctrl+V

Delete

Ctrl+Alt+Shift+ Down

Alt+Shift+5
Alt+Shift+T

F5

3

3

3
3
13

3

3

® import java.io.IOException;[]

main(string[] args) {
request.
= new Request();

equest parameters.

ppSecrect, Method and Url are required
Key("e71fe245-9cf6-4d75-822d-c29945aled
secret("c6e52419-227@8-4ch3-8bd4-ae7fdde
Method("GET");
Url("https://30@30113-3657-4fh6-a7ef-98
QueryStringParam("name”, "value");
Header("Content-Type”, “"text/plain”);
published in other gnvs(except for Rel
ddHeader|(|"x-stage”, "publish_env_name™)
gody ( “demo™);

ion e) {

xTrace();

ient client = null;

request.
Base signedRequest = Client.sign(reques
h : signedRequest.getAllHeaders()) {

put.println(h.getName() + ":" + h.getVa
brintln("---------nn "y
request.

sslContext = SSiCentexts.custon().leadT
pnsocketFactory sslSocketFactory = new .

1 |1 Java Application Alt+Shift+X, J

Run Configurations...

Step 5 On the Console tab page, view the running result.
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2.4 Go

Scenarios

Prerequisites

Figure 2-13 Response displayed if the calling is successful

'*| Problems |5\ Declaration B Conscle 2

=terminated= Main [Java Application] C:\Program Files\Javaijrel.8.0_191\bin\javaw.exe

HTTP/1.1

Date:Tue, 19 Mar 2019 @8:38:28 GMT
Content-Type:application/json
Transfer-Encoding:chunked
Connection:keep-alive

Server:api-gateway
X-Request-Id:844732a996756668d8d312ea362c9ea4)]
Access-Control-Allow-Origin:®

knngratulatians, sdk demo is runningl

--—-End

To use Go to call an API through app authentication, obtain the Go SDK, create a
new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2022.2.1 as an example.

e You have obtained API calling information. For details, see Preparation.

e You have installed Go 1.14 or a later version. If not, download the Go
installation package from the official Go website and install it.

e You have installed Intelli) IDEA 2022.2.1 or a later version. If not, download
the installation package from the official Intelli) IDEA website and install it.

e You have installed the Go plug-in on IntelliJ IDEA. If not, install the Go plug-in
according to Figure 2-14.

2025-02-21
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Figure 2-14 Installing the Go plug-in

Plugins

g
q Go Template
<>¥

GoToTabs
GoogleTranslation
GoYacc Support

google-java-format

Plugins

> Version Control

v Build, Execution, Deployment 2 Godot Theme

?

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Then obtain the ApiGateway-go-sdk.zip package. The following table shows the
files decompressed from the package.

Name Description

core\escape.go SDK code

core\signer.go

demo.go Sample code

Creating a Project

Step 1 Start IntelliJ IDEA and choose File > New > Project.

In the displayed New Project dialog box, set Name to the name of the folder in
the SDK package, Location to the decompression path of the folder, Language to
Go, and click Create.
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Figure 2-15 Go

Environment:

Add sample code

Create

Step 2 View the directory structure shown in the following figure.

Figure 2-16 Directory structure of the new project go

:
license-go

B demogo

Iraries

hes and Consoles

Modify the parameters in sample code demo.go as required. For details about the
sample code, see API Calling Example.

--—-End
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API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import the Go SDK (signer.go) to the project.
import "apig-sdk/go/core"

Generate a new signer and enter the AppKey and AppSecret.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD _SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Generate a new signer and enter the configured environment variables.
s := core.Signer{
Key: 0s.Getenv("CLOUD_SDK_AK"),
Secret: 0s.Getenv("CLOUD_SDK_SK"),
}

Generate a new request, and specify the domain name, method, request URL,
query parameters, and body.

r, _ = http.NewRequest("POST", "http://c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com/api?a=1&b=2",
ioutil. NopCloser(bytes.NewBuffer([]byte("foo=bar"))))

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
r.Header.Add("x-stage", "RELEASE")

Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:
s.Sign(r)

Access the APl and view the access result.

resp, err := http.DefaultClient.Do(r)
body, err := ioutil.ReadAll(resp.Body)

--—-End

2.5 Python

Scenarios

To use Python to call an API through app authentication, obtain the Python SDK,
create a new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2018.3.5 as an example.
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Prerequisites

You have obtained API calling information. For details, see Preparation.

You have installed Python 2.7.9 or 3.X. If not, download the Python
installation package from the official Python website and install it.

After Python is installed, run the pip command to install the requests library

in the CLI or Shell window.

pip install requests

(10 NOTE

If a certificate error occurs during the installation, download the get-pip.py file to

upgrade the pip environment, and try again.

e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download
the installation package from the official Intelli) IDEA website and install it.

e You have installed the Python plug-in on IntelliJ IDEA. If not, install the

Python plug-in according to Figure 2-17.

Figure 2-17 Installing the Python plug-in

Settings
Q- Plugins Marketplace 2
Appearance & Behavior
= ] 3
Keymap
) Search Results (41)
Editor
BEED ey
Version Control Languages
Build, Execution, Deployment The Python plug-in provides
smart editing for Python

Languages & Frameworks

. The feature set of the
Tools

Live Coding in Python
Code tools
Lets you run your Python
code as you type it. Di ys
variable value E or.
4, 2018 2157

Obtaining the SDK

==
Installed Updates o
MicrePython
Framework integration

Support for MicroP

devices in Intelli
PyCharm. Featu

2019 4 337K w49

python-typing-adder

Code toals

Cancel

On the APIG console, choose Help Center > Using SDKs, and download the SDK

of the desired language.

Then obtain the ApiGateway-python-sdk.zip package. The following table shows

the files decompressed from the package.

Name

Description

apig_sdk\__init__.py

apig_sdk\signer.py

SDK code
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Name Description
main.py Sample code
backend_signature.py Sample code for backend signing
licenses\license-requests Third-party license

Creating a Project
Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose Python and click Next.

Figure 2-18 Python

Mew Project =
Maven Project SDK: | 1 Python 3.7.2 <[ New.
Gradle Additional Libraries and Frameworks:

& Groovy [JEN Django
Grails [J¢€3 Google App Engine (Python)
Application Forge [ 25 5QL Support

© Go

“ Go Modules (vgo)

% Dep

‘s App Engine
Static Web

E Flash Template language:
& )
Application name:
K Kotlin
Enable Django admin
Empty Project 2

Mext Cancel Help

Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click
Finish.
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Figure 2-19 Selecting the SDK directory after decompression
New Project @

Project name: | py‘thonl |

Project location: | D:\java\python

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.

Figure 2-20 Directory structure of the new project python

v python
b Jidea
v ApiGateway-python-sdk-
v apig_sdk
_init__.py
signer.py
> licenses
main.py

test_signer.py
m Eython.iml

Modify the parameters in sample code main.py as required. For details about the
sample code, see API Calling Example.

--—-End

API Calling Example

Step 1 Import apig_sdk to the project.

from apig_sdk import signer
import requests
import os

Step 2 Generate a new signer and enter the AppKey and AppSecret.
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1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Generate a new signer and enter the configured environment variables.
sig = signer.Signer ()
sig.Key = os.getenv('CLOUD_SDK_AK")
sig.Secret = os.getenv('CLOUD_SDK_SK")

Step 3 Generate a request, and specify the method, request URI, header, and request
body.

r = signer.HttpRequest("POST",
"https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?a=1",
{"x-stage": "RELEASE"},
"body")

Step 4 Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:

X-Sdk-Date is a request header parameter required for signing requests.
sig.Sign(r)

Step 5 Access the API and view the access result.

resp = requests.request(r.method, r.scheme + "://" + r.host + r.uri, headers=r.headers, data=r.body)
print(resp.status_code, resp.reason)
print(resp.content)

--—-End

2.6 C#

Scenarios
To use C# to call an API through app authentication, obtain the C# SDK, open the
project file in the SDK, and then call the API by referring to the API calling
example.

Prerequisites

e You have obtained API calling information. For details, see Preparation.

e You have installed Visual Studio 2019 version 16.8.4 or a later version. If not,
download it from the official Visual Studio website and install it.

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.
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Then obtain the ApiGateway-csharp-sdk.zip package. The following table shows
the files decompressed from the package.

Name

Description

apigateway-signature\Signer.cs SDK code

apigateway-signature\HttpEncoder.cs

sdk-request\Program.cs

Sample code for signing requests

backend-signature\ Sample project for backend signing
csharp.sin Project file
licenses\license-referencesource Third-party license

Opening a Project

API Calling Example

Step 1

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:

apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.

backend-signature: Example of a backend service signature.

sdk-request: Example of invoking the signature algorithm. Modify the
parameters as required. For details about the sample code, see API Calling
Example.

Import the C# SDK to your project.

using System;

using System.Net;

using System.|O;

using System.Net.Http;
using System.Threading;
using APIGATEWAY_SDK;

Step 2 Generate a new signer and enter the AppKey and AppSecret.

1.

In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a.

Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

Run the following command to apply the modification:
source ~/.bashrc
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Step 3

Step 4

Step 5

Step 6

2. Generate a new signer and enter the configured environment variables.
Signer signer = new Signer();
signer.Key = Environment.GetEnvironmentVariable (" CLOUD_SDK_AK");
signer.Secret = Environment.GetEnvironmentVariable(" CLOUD_SDK_SK");

Generate an HttpRequest, and specify the method, request URL, and body.

HttpRequest r = new HttpRequest("POST",

new Uri("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?
query=value"));
rbody = "{\"a\":1}";

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.

r.headers.Add("x-stage", "RELEASE");

Execute the following function to generate HttpWebRequest, and add the X-Sdk-
Date and Authorization headers for signing the request:

HttpWebRequest req = signer.Sign(r);

Access the APl and view the access result.

try

{
var writer = new StreamWriter(req.GetRequestStream());
writer.Write(r.body);
writer.Flush();
HttpWebResponse resp = (HttpWebResponse)req.GetResponse();
var reader = new StreamReader(resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

catch (WebException e)

{
HttpWebResponse resp = (HttpWebResponse)e.Response;
if (resp != null)
{

Console.WriteLine((int)resp.StatusCode + " " + resp.StatusDescription);
var reader = new StreamReader(resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

}

else

{

Console.WriteLine(e.Message);

}
}
Console.WriteLine("---------------- ");
----End

2.7 JavaScript

Scenarios
To use JavaScript to call an API through app authentication, obtain the JavaScript
SDK, create a project, and then call the API by referring to the API calling example.
The JavaScript SDK can run in a Node.js or browser environment.
This section describes the procedure of using Intelli) IDEA 2018.3.5 to establish a
Node.js environment. It also provides examples of calling APIs using a browser.
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Preparing the Environment

You have obtained API calling information. For details, see Preparation.

You have installed Node.js 15.10.0 or a later version. If not, download it from
the official Node.js website and install it.

You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli) IDEA website and install it.

You have installed the Node.js plug-in on Intelli) IDEA. If not, install the
Node.js plug-in according to Figure 2-21.

Figure 2-21 Installing the Node.js plug-in

Settings

Appearance & Behavior

Keymap

Editor
==

Version Control

Build, Execution, Deployment

Languages & Frameworks

Tools

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Plugins

] 3

Search Results (6)

NodeJs

JavaScript
Support for Node.js projects.
Featur

Run Node,js
s from the IDE

LiveEdit

Web
With Live Edit you can see the
changes you made in your

Marketplace 2 Installed

Updates e}

Node.js Remote Interpreter
Network

Run and debug Nodejs

applications in the remote

Beame Insta-ssl plugin

Network
Beame.io Jetbrains plugin
Beame-insta-ss| provides

HTTPS tunnel far expasing

Cancel

Then obtain the ApiGateway-javascript-sdk.zip package. The following table
shows the files decompressed from the package.

Name Description
signer.js SDK code
node_demao.js Node.js sample code

demo.html

Browser sample code

demo_require.html

Browser sample code (loaded using

require)
test.js Test case
js\hmac-sha256.js Dependencies
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Name Description
licenses\license-crypto-js Third-party licenses
licenses\license-node

Creating a Project
Step 1 Start Intelli) IDEA and choose File > New > Project.

In the New Project dialog box, choose Static Web and click Next.

Figure 2-22 Static Web
New Project \EI

[ HTMLS Boilerplate
& React App
B Foundation

& Groovy
Grails

Application Forge
PP J B | Bootstrap

 Go A Angular)s
“ Go Modules (vgo) Y Angular CLI
E Dep 4 React Native

s App Engine

(2 Node,js and NPM

E Flash

. Web modules are used for developing Web applications using
l Kotlin technologies such as HTML/CSS, JavaScript, PHP and so on. They do
not support developing Java applications.

Python
= Empty Project 2

Il Cancel Help

Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.
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Figure 2-23 Selecting the SDK directory of JavaScript after decompression
MNew Project @

Project name: |Ja\raScript |

Project location: | D:\java'JavaScript

b Maore Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.

Figure 2-24 Directory structure of the new project JavaScript
W JavaScript

> idea

v ApiGateway-javascript-sdl-2.0.0
> IE
> licenses

i dema.html
i demo_require.html
5= node_demojs
1 package-lockjsan
i signergs
5 testjs
mJavaScriptiml
Il External Libraries

Scratches and Consoles

e node_demao.js: Sample code in Node.js. Modify the parameters in the sample

code as required. For details about the sample code, see API Calling Example
(Node.js).

demo.html: Browser sample code. Modify the parameters in the sample code

as required. For details about the sample code, see API Calling Example
(Browser).

2025-02-21 31



API Gateway
Developer Guide 2 Calling APIs Through App Authentication

Step 4 Click Edit Configurations.

Figure 2-25 Click Edit Configurations

Edit Configurations...

FH Save 'main’ Configuration

main
Step 5 Click + and select Node.js.

Figure 2-26 Selecting Node.js
Run/Debug Configurations

1] - m £ w

Add Mew Configuration

- l_IIUU'i'J'

£ Gruntjs

i

¥ Gulpjs
| JAR Application
55 JavaScript Debug
ﬁ lest

Ab JUnit

i Jupyter Notebook
K Kotlin

K Kotlin script

D Lettuce

M Maven

@ Mocha

5] Modeunit

Step 6 Set JavaScript file to node_demo.js and click OK.

Figure 2-27 Selecting node_demao.js

Run/Debug Configurations @
+ — B F [ 1 Name: | node demo.js [1share []Allow parallel run
~ (2 Nodejs . . . .
. : Configuration Browser / Live Edit V8 Profiling Logs
Cerfousion
> ¢ Python Naode interpreter: Project node (D3 \node.exe) 10153 ~ || o

> JTemplates

Nade parameters:

Working directory: D:\java\JavaScript\ApiGateway-javascript-sdk-2.0.0

JavaScript file: node_dema,js

Application parameters:

Environment variables:

--—-End

2025-02-21 32



API Gateway
Developer Guide

2 Calling APIs Through App Authentication

API Calling Example (Node.js)

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import signer.js to your project.

var signer = require('./signer")
var https = require('https')

Generate a new signer and enter the AppKey and AppSecret.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD _SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Generate a new signer and enter the configured environment variables.
var sig = new signer.Signer ()
sig.Key = process.env.CLOUD_SDK AK
sig.Secret = process.env.CLOUD_SDK SK

Generate a request, and specify the method, request URI, and request body.

var r = new signer.HttpRequest("POST", "c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com/app1?a=1");
rbody ='{"a":1}

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
rheaders = { "x-stage":"RELEASE" }

Execute the following function to generate HTTP(s) request parameters, and add
the X-Sdk-Date and Authorization headers for signing the request:
var opts = sig.Sign(r)

Access the APl and view the access result. If you access the APl using HTTPS,
change http.request to https.request.

var reg=http.request(opts, function(res){
console.log(res.statusCode)
res.on("data"”, function(chunk){
console.log(chunk.toString())
)
)
reg.on("error",function(err){
console.log(err.message)
)
req.write(r.body)
req.end()

--—-End

API Calling Example (Browser)

Step 1

To use a browser to access APIs, create an API that supports the OPTIONS
method. For details, see section "CORS" in the AP/ Gateway User Guide. And the
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returned header needs to carry related Access-Control-Allow-* header fields. You
can add these headers by enabling CORS when creating an API.

Step 2 Import signer.js and dependencies to the HTML page.

<script src="js/hmac-sha256.js"></script>

<script src="js/moment.min.js"></script>

<script src="js/moment-timezone-with-data.min.js"></script>
<script src='signer.js'></script>

Step 3 Sign the request and access the API.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD _SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

C.  Run the following command to apply the modification:
source ~/.bashrc

2. Enter the configured environment variables for signature and access.
var sig = new signer.Signer()
sig.Key = getenv('CLOUD_SDK_AK')
sig.Secret = getenv('CLOUD_SDK_SK')
var r= new signer.HttpRequest()
r.host = "c967a237-cd6¢c-470e-906f-a8655461897e.apigw.exampleRegion.com"
rmethod = "POST"
ruri = "/app1"
rbody ='{"a":1}'
rquery = { "a":"1","b":"2" }
rheaders = { "Content-Type":"application/json" }
var opts = sig.Sign(r)
var scheme = "https"
$.ajax({
type: opts.method,
data: reg.body,
processData: false,
url: scheme + "://" + opts.hostname + opts.path,
headers: opts.headers,
success: function (data) {
$('#status').html('200'")
$('#recv').html(data)
%
error: function (resp) {
if (resp.readyState === 4) {
$('#status').html(resp.status)
$('#recv').html(resp.responseText)
}else {
$('#status').html(resp.state())

}
by
timeout: 1000
b

--—-End
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2.8 PHP

Scenarios

Prerequisites

To use PHP to call an API through app authentication, obtain the PHP SDK, create
a new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2018.3.5 as an example.

e You have obtained API calling information. For details, see Preparation.

e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli)J IDEA website and install it.

e You have installed PHP 8.0.3 or a later version. If not, download it from the
official PHP website and install it.

e Copy the php.ini-production file from the PHP installation directory to the
C:\windows\ directory, rename the file as php.ini, and then add the following
lines to the file:
extension_dir = "PHP installation directory/ext"
extension=openssl
extension=curl

e You have installed the PHP plug-in on Intelli) IDEA. If not, install the PHP
plug-in according to Figure 2-28.

Figure 2-28 Installing the PHP plug-in

Settings =)
Q- Plugins Marketplace Installed Updates o
Appearance & Eehavior
= afFe ] 2
Keymap
. Search Results (129)
Editor
BETT - e PHP Annotations

Version Control K Llanguages Framework integration

Build, Execution, Deployment PHP 5.3-7.3 editing and PHP Annotation GitHub |

Languages & Frameworks dr:::uggil‘g 3:—13L,|.*i'. Smarty, Iss onate Installation
Twig and various frameworks

ook C 08, 2010 4 1.0M 735 4.3
PHP Toolbox PHP composer.json support

Framework integration Code editing
PHP Toolbox GitHub | Json PHP composer.json support
Examples | Donate This plugin Donate using PayPal or
provides "Method Bitcoin This plugin adds auto,
& 17,2017 £ 150.5K 5 c 10, 2019 +311.4K 5
o Canc

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.
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Then obtain the ApiGateway-php-sdk.zip package. The following table shows the

files decompressed from the package.

Name Description
signer.php SDK code
index.php Sample code

Creating a Project
Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose PHP and click Next.

Figure 2-29 PHP
Bl New Project @

& Groovy I} PHP Empty Project

Grails @ Composer Project

Application Forge
o Go
“ Go Modules (vgo)
= Dep
% App Engine

Static Web
(2 Nodejs and NPM

E Flash

X Create empty project for PHP
K Kotlin

Pythan

Empty Project

Cancel Help

Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.
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Figure 2-30 Selecting the SDK directory of PHP after decompression
New Project @

Project name: | php

Project location: | Di\java\php |

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.

Figure 2-31 Directory structure of the new project php
v [Lphp
> Jidea
v ApiGateway-php-sdk-
ahe index.php
ahw Signer.php
m Php.iml
» External Libraries

Scratches and Consoles

Modify the parameters in sample code signer.php as required. For details about
the sample code, see API Calling Example.

--—-End

API Calling Example
Step 1 Import the PHP SDK to your code.

require 'signer.php';
Step 2 Generate a new signer and enter the AppKey and AppSecret.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD_SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:
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Step 3

Step 4

Step 5

Step 6

2.9 C++

Scenarios

Prerequisites

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Generate a new signer and enter the configured environment variables.
$signer = new Signer();
$signer->Key = getenv('CLOUD_SDK_AK');
$signer->Secret = getenv('CLOUD_SDK_SK');

Generate a new request and specify the method, request URL, and body. (The
body should contain the actual request content.)
$req = new Request('GET', "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/
app1?a=1");
$req->body =";
Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
$reg->headers = array(
'x-stage' => 'RELEASE',
)
Execute the following function to generate a $Scurl context variable.
$curl = $signer->Sign($req);

Access the API and view the access result.

$response = curl_exec($curl);

echo curl_getinfo($curl, CURLINFO_HTTP_CODE);
echo $response;

curl_close($curl);

--—-End

To use C++ to call an API through App authentication, obtain the C++ SDK, and
then call the API by referring to the API calling example.

You have obtained API calling information. For details, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.

apt-get install libcurl4-openssl-dev

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Then obtain the ApiGateway-cpp-sdk.zip package. The following table shows the
files decompressed from the package.

2025-02-21

38



API Gateway
Developer Guide

2 Calling APIs Through App Authentication

Name Description
hasher.cpp SDK code
hasher.h

header.h

RequestParams.cpp

RequestParams.h

signer.cpp

signer.h

Makefile Makefile file
main.cpp Sample code

API Calling Example

Step 1

Step 2

Step 3

Step 4

Add the following references to main.cpp:

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.h"

Generate a new signer and enter the AppKey and AppSecret.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc
2. Generate a new signer and enter the configured environment variables.

Signer signer(getenv("CLOUD_SDK_AK"), getenv("CLOUD_SDK SK"));

Generate a new RequestParams request, and specify the method, domain name,
request URI, query strings, and request body.
RequestParams* request = new RequestParams("POST", "c967a237-cd6c-470e-906f-

a8655461897e.apigw.exampleRegion.com", "/app1",
"Action=ListUsers&Version=2010-05-08", "demo");

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
request->addHeader("x-stage", "RELEASE");
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Step 5 Execute the following function to add the generated headers to the request

Step 6

variable.
signer.createSignature(request);

Use the curl library to access the API and view the access result.

static size_t

WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)

{

}

size_t realsize = size * nmemb;
struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);

if (mem->memory == NULL) {
/* out of memory! */
printf("not enough memory (realloc returned NULL)\n");
return O;

}
memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;

mem->memory[mem->size] = 0;

return realsize;

//send http request using curl library
int perform_request(RequestParams* request)

{

CURL *curl;

CURLcode res;

struct MemoryStruct resp_header;
resp_header.memory = (char*)malloc(1);
resp_header.size = 0;

struct MemoryStruct resp_body;
resp_body.memory = (char*)malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, request->getMethod().c_str());
std::string url = "http://" + request->getHost() + request->getUri() + "?" + request->getQueryParams();

curl_easy_setopt(curl, CURLOPT_URL, url.c_str());
struct curl_slist *chunk = NULL;
std::set<Header>:iterator it;

for (auto header : *request->getHeaders()) {

std::string headerEntry = header.getKey() + ": " + header.getValue();

printf("%s\n", headerEntry.c_str());
chunk = curl_slist_append(chunk, headerEntry.c_str());

printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);

curl_easy_setopt(curl, CURLOPT_COPYPOSTFIELDS, request->getPayload().c_str());

curl_easy_setopt(curl, CURLOPT_NOBODY, OL);

curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);

//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res = CURLE_OK) {

}

else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);

fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));
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free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();

return 0O;

}

Step 7 Run the make command to obtain a main executable file, execute the file, and

then view the execution result.

--—-End

210 C

Scenarios

To use C to call an API through app authentication, obtain the C SDK, and then

call the API by referring to the API calling example.

Prerequisites

You have obtained API calling information. For details, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.

apt-get install libcurl4-openssl-dev

Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK

of the desired language.

Then obtain the ApiGateway-c-sdk.zip package. The following table shows the

files decompressed from the package.

Name

Description

sigher_common.c

signer_common.h

SDK code

signher.c
signer.h
Makefile Makefile file
main.c Sample code

API Calling Example

Step 1 Add the following references to main.c:
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Step 2

Step 3

Step 4

Step 5

Step 6

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.h"

Generate a sig_params_t variable, and enter the AppKey and AppSecret.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD SDK_AK and CLOUD_SDK_SK in the
local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Generate a sig_params_t variable, and enter the configured environment

variables.

sig_params_t params;

sig_params_init(&params);

sig_str_t app_key = sig_str(getenv("CLOUD_SDK AK"));
sig_str_t app_secret = sig_str(getenv("CLOUD_SDK SK"));
params.key = app_key;

params.secret = app_secret;

Specify the method, domain name, request URI, query strings, and request body.

sig_str_t host = sig_str("c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com");
sig_str_t method = sig_str("GET");

sig_str_t uri = sig_str("/app1");

sig_str_t query_str = sig_str("a=1&b=2");

sig_str_t payload = sig_str("");

params.host = host;

params.method = method;

params.uri = uri;

params.query_str = query_str;

params.payload = payload;

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
sig_headers_add(&params.headers, "x-stage", "RELEASE");

Execute the following function to add the generated headers to the request
variable.
sig_sign(&params);

Use the curl library to access the API and view the access result.

static size_t
WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)
{

size_t realsize = size * nmemb;

struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);
if (mem->memory == NULL) {

/* out of memory! */

printf("not enough memory (realloc returned NULL)\n");

return O;
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}

memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;
mem->memory[mem->size] = 0;

return realsize;

}

//send http request using curl library
int perform_request(RequestParams* request)
{
CURL *curl;
CURLcode res;
struct MemoryStruct resp_header;
resp_header.memory = malloc(1);
resp_header.size = 0;
struct MemoryStruct resp_body;
resp_body.memory = malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, params.method.data);
char url[1024];
sig_snprintf(url, 1024, "http://%V%V?%V", &params.host, &params.uri, &params.query_str);
curl_easy_setopt(curl, CURLOPT_URL, url);
struct curl_slist *chunk = NULL;
for (inti = 0; i < params.headers.len; i++) {
char header[1024];
sig_snprintf(header, 1024, "%V: %V", &params.headers.data[i].name, &params.headers.datali].value);
printf("%s\n", header);
chunk = curl_slist_append(chunk, header);
}
printf("'------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);
curl_easy_setopt(curl, CURLOPT_POSTFIELDS, params.payload.data);
curl_easy_setopt(curl, CURLOPT_NOBODY, OL);
curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);
//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res !'= CURLE_OK) {
fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));
}
else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);
}
free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();
//free signature params
sig_params_free(&params);
return O;

}

Step 7 Run the make command to obtain a main executable file, execute the file, and
then view the execution result.

--—-End
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2.11 Android

Scenarios

To use Android to call an API through app authentication, obtain the Android SDK,
create a new project, and then call the API by referring to the API calling example.

Prerequisites
e  You have obtained API calling information. For details, see Preparation.
e You have installed Android Studio 4.1.2 or a later version. If not, download it

from the official Android Studio website and install it.
Obtaining the SDK

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Then obtain the ApiGateway-android-sdk.zip package. The following table shows
the files decompressed from the package.

Name Description

app\ Android project code
gradle\ Gradle files

build.gradle Gradle configuration files

gradle.properties

settings.gradle

gradlew Gradle Wrapper scripts

gradlew.bat

Opening a Project
Step 1 Start the Android Studio and choose File > Open.
Select the directory where the SDK is decompressed.

Step 2 View the directory structure of the project shown in the following figure.
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Figure 2-32 Project directory structure

e app
b manifests
w Java
hd com.testappsignature
£ MainActivity
> com.test.appsignature (androidTest)
> com.test.appsignature (test)
v res
3 drawable
v layout
25 activity_main.eml
> mipmap
> values

v (# Gradle Scripts

# build.gradle (Project: android)

#} build.gradle (Module: app)
gradle.properties (Global Properties)
gradle-wrapper.properties (Gradle Version)

=| proguard-rules.pro (ProGuard Rules for app)
gradle.properties (Froject Properties)

#) settings.gradle (Project Settings)

-

local.properties (S0 Location)

--—-End

API Calling Example

Step 1

Step 2

Step 3

Add required JAR files to the app/libs directory of the Android project. The
following JAR files must be included:

e  java-sdk-core-x.x.x.jar
e commons-logging-1.2.jar
e joda-time-2.10.jar

Add dependencies of the okhttp library to the build.gradle file.

Add implementation 'com.squareup.okhttp3:0khttp:3.14.2' in the dependencies
field of the build.gradle file.

dependencies {

implementation 'com.squareup.okhttp3:okhttp:3.14.3'
}

Create a request, enter an AppKey and AppSecret, and specify the domain name,
method, request URI, and body.

1. In this example, the AK and SK stored in the environment variables are used.
Specify the environment variables CLOUD _SDK_AK and CLOUD_SDK_SK in the
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Step 4

2.12 curl

Scenarios

Prerequisites

local environment first. The following uses Linux as an example to describe
how to set the obtained AK/SK as environment variables.

a. Open the terminal and run the following command to open the
environment variable configuration file:

vi ~/.bashrc

b. Set environment variables, save the file, and exit the editor.
export CLOUD_SDK_AK="Obtained AK"
export CLOUD_SDK_SK="Obtained SK"

¢. Run the following command to apply the modification:
source ~/.bashrc

2. Create a request, enter the configured environment variables, and specify the

domain name, method, request URI, and body.
Request request = new Request();
try {
request.setKey (System.getenv(" CLOUD_SDK_AK"));
request.setSecret(System.geten(" CLOUD_SDK_SK"));
request.setMethod("POST");
request.setUrl("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1");
request.addQueryStringParam("name", "value");
request.addHeader("Content-Type", "text/plain");
request.setBody("demo");
} catch (Exception e) {
e.printStackTrace();
return;

}

Sign the request to generate an okhttp3.Request object for API access.

okhttp3.Request signedRequest = Client.signOkhttp(request);
OkHttpClient client = new OkHttpClient.Builder().build();
Response response = client.newCall(signedRequest).execute();

--—-End

To use the curl command to call an API through app authentication, download the
JavaScript SDK to generate the curl command, and copy the command to the CLI
to call the API.

You have obtained API calling information. For details, see Preparation.

API Calling Example

Step 1

Use the JavaScript SDK to generate the curl command.

On the APIG console, choose Help Center > Using SDKs, and download the SDK
of the desired language.

Open demo.html in a browser. The following figure shows the demo page.
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Step 2

Step 3
Step 4

Apigateway Signature Test

Key

071fe245-9cf6-4d75-822d-c29945a1e06a

Secret
Method Url

GET s 30030113-3657-4fb6-a7ef-90764239b038
Headers

{"Content-Type":"application/json"}
Body

e

curl -X GET "http://30030113-3657-4fb6-a7ef-90764239b03!
d.com/" -H "X-Sdk-Date: 20190731T065514Z" -H "host: 30030113-3657-4fb6-a7ef-9076423

Note: accessing the API from browser requires support for CORS
200
Congratulations, sdk dema is running

Specify the key, secret, method, protocol, domain name, and URL.

Key=415f****100c

Secret=***#**

Method=POST
Url=https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com

Specify query and header parameters in JSON format, and set the request body.

Click Send request to generate a curl command. Copy the curl command to the
CLI to access the API.

$ curl -X POST "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/" -H "X-Sdk-
Date: 20180530T115847Z" -H "Authorization: SDK-HMAC-SHA256 Access=071f***e06a,
SignedHeaders=host;x-sdk-date, Signature=9e5314bd156d517*****dd3e5765fdde4" -d ""
Congratulations, sdk demo is running

The curl command generated using an SDK does not meet the format
requirements of Windows. Please run the curl command in Git Bash.

--—-End
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Calling APIs Through IAM
Authentication

3.1 Token Authentication

Scenarios

To call APIs using a token, add the token to the X-Auth-Token header in API
requests.

(11 NOTE

You can use either of the following authentication methods to call APIs:
e Token authentication: Requests are authenticated using a token.

e AK/SK authentication: Requests are encrypted using an access key ID (AK) and a secret
access key (SK).

API Calling Example

1. Obtain a token and set it as an environment variable for authenticating the
calling of other APIs.

a. Obtain a token. An example request is as follows:
curl -X POST https://{iam_endpoint}/v3/auth/tokens -H 'content-type: application/json' -d '{
"auth": {
"identity": {

"methods": [
"password"

]I

"password": {
"user": {
"name": "{user_namej}",

"domain": {

}I

"password": "{password}'

}
h?
"scope": {

"project™: {
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"id": "{project_id}"
}
}

}
} -vk

Modify the parameters in the preceding command according to the
following description. For details, see the API forObtaining a User Token
in the /dentity and Access Management APl Reference.

®  Obtain the flam_endpoint} from Regions and Endpoints.

" Replace {user name} and {password} respectively with the
username and password of the IAM server.

= {project id} The project ID. On the management console, hover the
mouse pointer over the username in the upper right corner, click the
username, choose My Credentials from the drop-down list, and then
view the project ID on the displayed page.

The token value is the X-Subject-Token value in the response header as
shown below:
Figure 3-1 Obtaining the X-Subject-Token response header

connection — keep-alive

content-type — application/json

date — Mon, 05 Nov 2018 09:55:39 GM
server — Web Server
strict-transport-security — max-age=31536000; includeSubdomains
transfer-encoding — chunked

via = proxy A

x-content-type-options — nosniff

x-download-options — noopen

x-frame-options - SAMEORIGIN

¥-iam-trace-id 77:5::"_5.3:.351 3d440f7854f1cd

x-subject-token

Run the following command to set an environment variable for passing
the token:

export Token={X-Subject-Token}

X-Subject-Token is the token obtained in 1.a. Example:
export Token=MIIDkg****BZQMEAgEwg

To call an API, obtain the domain name, request method, and URL by
referring to Preparation, add X-Auth-Token to the request header, and set
the value of X-Auth-Token to the token obtained in 1. Set the parameters
based on the site requirements.
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curl -X Request_method Domain name+URL -H "x-auth-token: $Token" -vk

3.2 AK/SK Authentication

This section describes how to use AK and SK to sign requests.

e AK: access key ID, which is a unique identifier used in conjunction with a
secret access key to sign requests cryptographically.

e SK: secret access key used in conjunction with an AK to sign requests
cryptographically. It identifies a request sender and prevents the request from
being modified.

Generating an AK and SK Pair

If an AK/SK pair has already been generated, skip this step. Find the downloaded
AK/SK file, which is usually named credentials.csv.

As shown in the following figure, the file contains the username, access key ID,
and secret access key.

Figure 3-2 Content of the credential.csv file

4 E C
1 |User Hame Access Key Id Secret Access Eey
2 RN CWMIORSTEETIHIVERT | zul TR eRDET TE iR Ve o¥bhSzsdaGw4
Note:

1.  You can create a maximum of two access keys with identical permissions and
unlimited validity and cannot increase the quota. Each access key can be
downloaded only once when created. Keep your access keys secure and
change them periodically for security purposes. To change an access key,
delete it and create a new one.

2. Federated users can only create temporary access credentials (temporary
AK/SKs and security tokens). .

3. If you are an administrator, you can view the AK of an IAM user on the user
details page. The SK is kept by the user.

Perform the following procedure to generate an AK/SK pair:

Step 1 Log in to the.

Step 2 Hover the cursor on the username and choose My Credentials from the drop-
down list.

Step 3 Click the Access Keys tab.

Step 4 Click Create Access Key.

Each user can create a maximum of two access keys. The quota cannot be
increased.

e To change an access key, delete it and create a new one.

Step 5 Enter a description, and click OK.
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Step 6 In the displayed dialog box, click Download to save the access key.

You can obtain the AK from the access key list and SK from the downloaded CSV
file.

e  For details about how to obtain a temporary AK/SK, see the /dentity and
Access Management AP/ Reference.

e Keep the CSV file properly. You can only download the file right after the
access key is created. However, if you cannot find the file to obtain the key
information, you can create a key.

e Open the CSV file in the lower left corner, or choose Downloads in the
browser and open the CSV file.

e  For security purposes, keep your access keys secure and change them
periodically.

--—-End

Generating a Signature

Generate a signature in the same way as in App authentication mode. Replace
AppKey with AK and replace AppSecret with SK to complete the signing and
request processing. You can sign requests to access APIs by using Java, Go,
Python, C#, JavaScript, PHP, C++, C, and Android.

NOTICE

e The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

e APIG (APl Management) checks the time format and compares the time with
the time when APIG (APl Management) receives the request. If the time
difference exceeds 15 minutes, APIG will reject the request.
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Creating Signatures for Backend
Requests

4.1 Pre-signature Preparations

Obtaining signature key information:

On the APIG console, choose API Publishing > Signature Keys. Click the signature
key name to go to the details page and view the key and secret.

4.2 Java

Scenarios
To use Java to sign backend requests, obtain the Java SDK, import the project, and
verify the backend signature by referring to the example provided in this section.
This section uses Intelli) IDEA 2018.3.5 as an example.

Constraints
Signature information is added to requests sent to access the backend of an API
only after a signature key is bound to the API.

Prerequisites

e You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Creating and Using a
Signature Key" in the AP/ Gateway User Guide.

e You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

e On the APIG console, choose Help Center > Using SDKs, and download the
SDK of the desired language.

e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli) IDEA website and install it.
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e You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it. JDK 17 or
later is not supported.

Importing a Project

Step 1 Open Intelli) IDEA, choose File > New > Project from Existing Sources, select the
apigateway-backend-signature-demo\pom.xml file, and click OK.

Figure 4-1 Select File or Directory to Import

Select File or Directory to Import >

Select directory with existing sources,

Eclipse project (.project) or classpath (.classpath] file,
Maven project file (pom.xml),

End/Bndtools workspace (workspace/cnf),

Gradle build script (*.gradle],

Flash Builder project file (.project, *.fxp, *.fxpl).

f O g X G % Hide path
GpiGateway-sdki\apigateway-backend-signature-demol\pom.xml| | &
> ApiGateway-android-sdk-1.0.0

v apigateway-backend-signature-demo
> idea
> libs
b src

E'.-

and drop a file into the space above to quickly locate it in the tree

g
o

Step 2 Retain the default settings, click Next for the following four steps, and then click
Finish.

Step 3 On the Maven tab page on the right, double-click compile to compile the file.
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Figure 4-2 Compiling the project

Mawven o —
S R i+ m M ® | F

~ |, backend-signature
w Lifecycle

clean

validate

2
test 1

package

verify

install

site

deploy
» Plugins

» [iiDependencies

aseqeyed ([

UoREpI|Es UBRE 5 |uanew 3 | MBS

If the message "BUILD SUCCESS" is displayed, the compilation is successful.

Run: backend-signature [compile]
[I1F0]

[IVFO] Cepying 1 resource
[INFO] Copying O resource
[I1FO]

I 4l

[INFO] --- maven-resources—plugin:3.1. 0 resowrces (default-resources) @ backend-signature ——-

[INFO] Using "UTF-8 encoding to copy filtered resources.

[IWFO] -—- maven—compiler-plugin:3. 8 0:compile (default-compile) @ backend-signature ——-
[IVFO] Nothing to compile - all classes are up to date

[11F0]
[INFO]|EUILD SUCCESS

[I1FO]
[INFO] Tetal time: 2.688 s

}* [IVFO] Finished at: 2019-03-11T18:41:09405:00
[INFO] Final Memory: Z21M/309M

[IWFO]

Process finished with exit code O

Step 4 Right-click BackendSignatureApplication and choose Run.
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Figure 4-3 Running the BackendSignatureApplication service

v apigateway-backend-signature-demo packa
> Jdea
> Dulibs 12 .
v src 2 Cut Ctrl+X
v main B Copy Ctrl+C
v java Copy Path Ctrl+Shift+C
hd corr apigat  Copy Reference Ctrl+Alt+Shift+C
& ApigatewaySigr [] Paste Ctrl+V
% BackendSignati £ Jump to Source F4
@ HelloController Find Usages Alt+F7
€ ReguestWrapp: Analyze )
> resgurces Felodar ¥
> farget Zea-“ Python Compiled Files
pom.xm| Add to Favorites y
» |l External Libraries
Browse Type Hierarchy Ctrl+H
¥ Scratches and Consoles
Reformat Code Cirl+Alt+L
Optimize Imports Ctrl+Alt+0
Delete... Delete

Build Module 'apigateway-backend-signature-dema’
Ctrl+Shift+F2
Ctrl+Shift+F10

Recompile '..ureApplication,java'

Run ‘BackendSignatureAppl...’
## Debug 'BackendSignatureAppl...
U Run 'BackendSignaturefAppl.." with Coverage

@ Create 'BackendSignatureAppl.'..

Modify the parameters in sample code ApigatewaySignatureFilter.java as
required. For details about the sample code, see Backend Signature Verification
Example.

--—-End

Backend Signature Verification Example

This example demonstrates how to build a Spring boot-based server as the
backend of an APl and implement a filter to verify the signature of requests sent
from APIG (APl Management).

Step 1 Compile a controller that matches all request paths and methods and set the

return body to Hello World!

// HelloController.java

@RestController
@EnableAutoConfiguration
public class HelloController {

@RequestMapping("/*")
private String index() {
return "Hello World!";

}
}
Step 2 Compile a filter that matches all request paths and methods, and put the
signature key and secret in a Map.
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Step 3

Step 4

Step 5

// ApigatewaySignatureFilter.java

@Component
@WebfFilter(filterName = "ApigatewaySignatureFilter", urlPatterns = "/*")
public class ApigatewaySignatureFilter implements Filter {

private static Map<String, String> secrets = new HashMap<>();

static {

secrets.put(System.getenv("SDK_AKT"), System.getenv("SDK SKT"));
secrets.put(System.getenv("SDK_AKZ"), System.getenv("SDK SK2"));
}

@Override
public void init(FilterConfig filterConfig) throws ServletException {
}

@Override
public void doFilter(ServletRequest servletRequest, ServletResponse servletResponse, FilterChain chain) {
//Signature verification code

)
}

To ensure that the body can be read in the filter and controller, wrap the request
and send it to the filter and controller. The doFilter function is used for signature
verification. For the implementation of wrapper classes, see RequestWrapper.java.
RequestWrapper request = new RequestWrapper((HttpServletRequest) servletRequest);

Use a regular expression to parse the Authorization header to obtain signingKey
and signedHeaders.

private static final Pattern authorizationPattern = Pattern.compile("SDK-HMAC-SHA256\\s+Access=([A]+),\
\s?SignedHeaders=([A,]+),\\s?Signature=(\\w+)");

String authorization = request.getHeader("Authorization");

if (authorization == null || authorization.length() == 0) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization not found.");
return;

}

Matcher m = authorizationPattern.matcher(authorization);

if (!Im.find()) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization format incorrect.");
return;

}

String signingKey = m.group(1);

String signingSecret = secrets.get(signingKey);

if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}
String[] signedHeaders = m.group(2).split(";");
For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5*******8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find signingSecret based on signingKey. If signingKey does not exist, the
authentication failed.
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String signingSecret = secrets.get(signingKey);

if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}

Step 6 Create a request, and add the method, URL, query, and signedHeaders headers to
the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

Request apiRequest = new DefaultRequest();
apiRequest.setHttpMethod (HttpMethodName.valueOf(request.getMethod()));
String url = request.getRequestURL().toString();
String queryString = request.getQueryString();
try {
apiRequest.setEndpoint((new URL(url)).toURI());
Map<String, String> parametersmap = new HashMap<>();
if (null != queryString && !"".equals(queryString)) {
String[] parameterarray = queryString.split("&");
for (String p : parameterarray) {
String[] p_split = p.split("=", 2);
String key = p_split[0];
String value = "";
if (p_split.length >=2) {
value = p_split[1];
}
parametersmap.put(URLDecoder.decode(key, "UTF-8"), URLDecoder.decode(value, "UTF-8"));
}

apiRequest.setParameters(parametersmap); //set query

} catch (URISyntaxException e) {
e.printStackTrace();
}

boolean needbody = true;
String dateHeader = null;
for (inti = 0; i < signedHeaders.length; i++) {
String headerValue = request.getHeader(signedHeaders[i]);
if (headerValue == null || headerValue.length() == 0) {
((HttpServletResponse) response).sendError(HttpServletResponse.SC_UNAUTHORIZED, "signed
header" + signedHeaders[i] + " not found.");
} else {
apiRequest.addHeader(signedHeaders[i], headerValue);//set header
if (signedHeaders[i].toLowerCase().equals("x-sdk-content-sha256") &&
headerValue.equals("UNSIGNED-PAYLOAD")) {
needbody = false;
}
if (signedHeaders[i].toLowerCase().equals("x-sdk-date")) {
dateHeader = headerValue;
}
}
}

if (needbody) {
apiRequest.setContent(new ByteArraylnputStream(request.getBody())); //set body
}

Step 7 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

private static final DateTimeFormatter timeFormatter =
DateTimeFormat.forPattern("yyyyMMdd'T'HHmmss'Z'").withZoneUTC();

if (dateHeader == null) {
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response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Header x-sdk-date not found.");
return;

}

long date = timeFormatter.parseMillis(dateHeader);

long duration = Math.abs(DateTime.now().getMillis() - date);

if (duration > 15 * 60 * 1000) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signature expired.");
return;

}

Step 8 Add the Authorization header to the request, and invoke the verify method to
verify the request signature. If the verification is successful, the next filter is
executed. Otherwise, the authentication failed.

apiRequest.addHeader("authorization", authorization);
apiRequest.setKey(signingKey);
apiRequest.setSecret(signingSecret);
Signer signer = new Signer();
boolean verify = signer.verify(apiRequest);
if (verify) {
chain.doFilter(request, response);
} else {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Verify authorization failed.");
}

Step 9 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns Hello World!

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.
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Apigateway Signature Test

signature_key1

Secret

signature_secret1

Method Scheme Host Url
POST = http  # | localhost:8080 test
Query
(oo yyy )
y
Headers
{"aaa" bbb’}
Body
dsfasdf=1

Debug

curl -X POST "http://localhost:8080/testhoo=yyy" -H "aaa: bbb" -H "X-Sdk-Date: 20190307T
122402Z" -H "host: localhost:8080" -H “Authorization: SDK-HMAC-SHA256 Access=signatur X

--—-End

4.3 Python

Scenarios
To use Python to sign backend requests, obtain the Python SDK, import the
project, and verify the backend signature by referring to the example provided in
this section.
This section uses IntelliJ IDEA 2018.3.5 as an example.

Constraints

Signature information is added to requests sent to access the backend of an API
only after a signature key is bound to the API.

Preparing the Environment

e You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Creating and Using a
Signature Key" in the AP/ Gateway User Guide.

e You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

e On the APIG console, choose Help Center > Using SDKs, and download the
SDK of the desired language.
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e You have installed Python 2.7.9 or 3.X. If not, download the Python
installation package from the official Python website and install it.

e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli) IDEA website and install it.

e You have installed the Python plug-in on IntelliJ IDEA. If not, install the
Python plug-in according to Figure 4-4.

Figure 4-4 Installing the Python plug-in

Settings [
Qr Plugins 2 Installed Updates o ]
Appearance & Behavior Q
~ [Python 3
coman prver |
Edit Search Results (41)
itor

BEEDEE ey MicraPython

Version Control

Languages Framework integration

Build, Execution, Deployment

Languages & Frameworks

The Python plug-in provides
smart editing for Python
scripts. The feature set of the...

Support for MicroPython
devices in Intelli) IDEA and
PyCharm. Features: Code...

wES 3.9 e 12,2019 + 337K tr4.9
Live Coding in Python python-typing-adder
Code tools Code toals

Lets you run your Python Using intellj to infer
code as you type 5 Python typing and add type
variable values, matplotlib, or... comments using the typing...

c 14,2018 L 157K o 14,2017 L 2

o

Importing a Project

Step 1

Start Intelli) IDEA and choose File > New > Project.

On the displayed New Project page, choose Python and click Next.
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Figure 4-5 New Python

MNew Project

Maven

Gradle

G Groovy
Grails

Application Forge
o Go
“ Go Modules (vgo)
% Dep
‘s App Engine

Static Web

E Flash

_ Templates folder: templates
& Python

K Kotlin

& Empty Project

Project SDK: | & Python 372 (D4 [ pythonexe)  ~ || New..
Additional Libraries and Framewarks:
U] Diango
1€ Google App Engine (Python)
(]2, 5QL Support
Template language:
Application name:
Enable Django admin
Cancel Help

Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click

Finish.

Figure 4-6 Selecting the SDK directory of Python after decompression

Mew Praoject

=3

Project name: | p)-'thcunl

Project location: | Di\java\python

b More Settings

Previous Cancel Help
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Step 3 View the directory structure shown in the following figure.

Figure 4-7 Directory structure

b python
> idea I
> apig_sdk
» licenses

» backend_signature.py
= main.py
m Python.iml
= test_signer.py
= VERSION
¥ Il External Libraries

» FgScratches and Consales

Step 4 Click Edit Configurations.

Figure 4-8 Edit Configurations

— Edit Configurations...

Step 5 Click + and choose Flask server.

Figure 4-9 Choosing Flask server

Run/Debug Configurations

I[= Cucumber java

Add New Configuration

o Docker 2
@ rfirefox Remote

s Go App Engine
“4 Go Build

= l Go Remote

‘v Go Test

Step 6 Set Target type to Script path, select backend_signature.py from the Target

drop-down list box, and click OK.
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+ - B A | Name:  Flask (backend signature.py) []share []Allow parallel run
v {_Flask server

Confi ti L
{_Flask (backend_signature.py) e =

> Templates Target type: O Module name @ Script path O Custom
Target: ‘\python\backend_signature.py
Application:

Additional options:

FLASK ENV: development
FLASK_DEBUG: O
* Environment

Environment variables:
Python Interpreter: () Use SDK of madule:

(®) Use specified interpreter: Python 3.7

Interpreter options:
Working directory:
Add content roots to PYTHONPATH
Add source roots to PYTHONPATH

(2] Cancel || Apply

--—-End

Backend Signature Verification Example

This example demonstrates how to build a Flask-based server as the backend of
an APl and implement a wrapper to verify the signature of requests sent from
APIG (APl Management).

Step 1 Compile an interface that returns Hello World! Configure the GET, POST, PUT, and
DELETE methods and the requires_apigateway_signature wrapper.
app = Flask(__name_ )

@app.route("/<id>", methods=['GET', 'POST', 'PUT', 'DELETE'])
@requires_apigateway_signature()
def hello(id):

return "Hello World!"

Step 2 Implement requires_apigateway_signature by putting the signature key and
secret in a dict.

def requires_apigateway_signature():
def wrapper(f):

secrets = {

os.getenv('SDK_AKT'): os.getenv('SDK_SKT'),
os.getenv('SDK_AKZ2): os.getenv('SDK_SKZ2),

}

authorizationPattern = re.compile(
r'SDK-HMAC-SHA256\s+Access=([A,]+),\s?SignedHeaders=([A,]+),\s?Signature=(\w+)")
BasicDateFormat = "%Y%m%dT%H%M%SZ"

@wraps(f)

def wrapped(*args, **kwargs):
//Signature verification code

return f(*args, **kwargs)
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return wrapped
return wrapper

Step 3 Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The wrapped function is used for signature
verification.

if "authorization" not in request.headers:

return 'Authorization not found.', 401
authorization = request.headers['authorization']
m = authorizationPattern.match(authorization)
if m is None:

return 'Authorization format incorrect.', 401
signingKey = m.group(1)
signedHeaders = m.group(2).split(";")

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Step 4 Find secret based on key. If key does not exist, the authentication failed.

if signingKey not in secrets:
return 'Signing key not found.', 401
signingSecret = secrets[signingKey]

Step 5 Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

r = signer.HttpRequest()
r.method = request.method
ruri = request.path
rquery = {}
for k in request.query_string.decode('utf-8').split('&'"):
spl = k.split("=", 1)
if len(spl) < 2:
rquery[spl[0]] = ""
else:
rquery[spl[0]] = spl[1]
r.headers = {}
needbody = True
dateHeader = None
for k in signedHeaders:
if k not in request.headers:
return 'Signed header ' + k + ' not found', 401
v = request.headers[k]
if k.lower() == 'x-sdk-content-sha256' and v == 'UNSIGNED-PAYLOAD"
needbody = False
if k.lower() == 'x-sdk-date":
dateHeader = v
r.headers[k] = v
if needbody:
rbody = request.get_data()

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

if dateHeader is None:
return 'Header x-sdk-date not found.', 401
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t = datetime.strptime(dateHeader, BasicDateFormat)
if abs(t - datetime.utcnow()) > timedelta(minutes=15):
return 'Signature expired.', 401

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.
sig = signer.Signer()
sig.Key = signingKey
sig.Secret = signingSecret
if not sig.Verify(r, m.group(3)):
return 'Verify authorization failed.', 401

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns 200.

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.

Apigateway Signature Test

Key
signature_key1

Secret

signature_secret

Method Scheme Host urd
POST = http  # | localhost:8080 Jtest
Query
{300 " yyy")
4
Headers

Body
dsfasdf=1

#

Debug

curl -X POST "http://localhost:8080/test?xxx=yyy" -H “aaa: bbb" -H "X-Sdk-Date: 20190307T
122402Z" -H “host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur >

--—-End
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4.4 C#

Scenarios

Constraints

To use C# to sign backend requests, obtain the C# SDK, import the project, and
verify the backend signature by referring to the example provided in this section.

Signature information is added to requests sent to access the backend of an API
only after a signature key is bound to the API.

Preparing the Environment

You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Creating and Using a
Signature Key" in the AP/ Gateway User Guide.

On the APIG console, choose Help Center > Using SDKs, and download the
SDK of the desired language.

You have installed Visual Studio 2019 version 16.8.4 or a later version. If not,
download it from the official Visual Studio website and install it.

Opening a Project

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:

apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.

backend-signature: Example of a backend signature. Modify the parameters
as required. For details about the sample code, see Backend Signature
Verification Example.

sdk-request: Example of invoking the signature algorithm.

Backend Signature Verification Example

Step 1

This example demonstrates how to build an ASP.Net Core-based server as the
backend of an APl and implement an lAuthorizationFilter to verify the signature of
requests sent from APIG (APl Management).

Write a controller that provides the GET, POST, PUT, and DELETE interfaces, and
add the ApigatewaySignatureFilter attribute.

// ValuesController.cs

namespace backend_signature.Controllers

{

[Route("api/[controller]")]

[ApiController]

[ApigatewaySignatureFilter]

public class ValuesController : ControllerBase
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// GET api/values
[HttpGet]
public ActionResult<IEnumerable<string>> Get()
{
return new string[] { "value1", "value2" };

}

// POST api/values

[HttpPost]

public void Post([FromBody] string value)
{

}

// PUT api/values/5

[HttpPut("{id}")]

public void Put(int id, [FromBody] string value)
{

}

// DELETE api/values/5
[HttpDelete("{id}")]
public void Delete(int id)
{
}
}
}

Step 2 Implement ApigatewaySignatureFilter by putting the signature key and secret in
a Dictionary.
// ApigatewaySignatureFilter.cs

namespace backend_signature.Filters

public class ApigatewaySignatureFilter : Attribute, IAuthorizationFilter
{
private Dictionary<string, string> secrets = new Dictionary<string, string>
{
{"signature_key1", "signature_secret1" },
{"signature_key2", "signature_secret2" },

{Environment.GetEnvironmentVariable("SDK AKT"),
Environment.GetEnvironmentVariable("SDK_SKT") },
{Environment.GetEnvironmentVariable("SDK _AK2"),
Environment.GetEnvironmentVariable("SDK_SK2') },
I

public void OnAuthorization(AuthorizationFilterContext context) {
//Signature verification code

)
}
}

Step 3 Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The OnAuthorization function is used for signature
verification.

private Regex authorizationPattern = new Regex("SDK-HMAC-SHA256\\s+Access=([A,]+),\\s?
SignedHeaders=([A,]+),\\s?Signature=(\\w+)");

string authorization = request.Headers["Authorization"];
if (authorization == null)
{

context.Result = new UnauthorizedResult();

return;
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Step 4

Step 5

}
var matches = authorizationPattern.Matches(authorization);
if (matches.Count == 0)
{
context.Result = new UnauthorizedResult();
return;
}
var groups = matches[0].Groups;
string key = groups[1].Value;
string[] signedHeaders = groups[2].Value.Split(';');

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find secret based on key. If key does not exist, the authentication failed.

if (!secrets.ContainsKey(key))

{
context.Result = new UnauthorizedResult();
return;

}

string secret = secrets[key];

Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

HttpRequest sdkRequest = new HttpRequest();
sdkRequest.method = request.Method;

sdkRequest.host = request.Host.Value;

sdkRequest.uri = request.Path;

Dictionary<string, string> query = new Dictionary<string, string>();
foreach (var pair in request.Query)

query[pair.Key] = pair.Value;

}
sdkRequest.query = query;
WebHeaderCollection headers = new WebHeaderCollection();
string dateHeader = null;
bool needBody = true;
foreach (var h in signedHeaders)
{
var value = request.Headers[h];
headers[h] = value;
if (h.ToLower() == "x-sdk-date")

dateHeader = value;
}
if (h.ToLower() == "x-sdk-content-sha256" && value == "UNSIGNED-PAYLOAD")

needBody = false;
}

sdkRequest.headers = headers;
if (needBody)
{

request.EnableRewind();
using (MemoryStream ms = new MemoryStream())

request.Body.CopyTo(ms);
sdkRequest.body = Encoding.UTF8.GetString(ms.ToArray());
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}

request.Body.Position = 0;

}

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.
private const string BasicDateFormat = "yyyyMMddTHHmMmssZ";

if(dateHeader == null)
{

context.Result = new UnauthorizedResult();
return;

}
DateTime t = DateTime.ParseExact(dateHeader, BasicDateFormat, Culturelnfo.CurrentCulture);
if (Math.Abs((t - DateTime.Now).Minutes) > 15)

context.Result = new UnauthorizedResult();
return;

}

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.

Signer signer = new Signer();

signer.Key = key;

signer.Secret = secret;

if (!signer.Verify(sdkRequest, groups[3].Value))

context.Result = new UnauthorizedResult();

}

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns 200.

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.
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Apigateway Signature Test

Key
signature_key1

Secret

signature_secret1

Method Scheme Host url
POST # http  # localhost:8080 [test

Query

o0y}

Headers

{"aaa":"bbb"}

Body

dsfasdf=1

“

curl -X POST “http://localhost:8080/test?xxx=yyy" -H “aaa: bbb" -H "X-Sdk-Date: 20190307T
122402Z" -H "host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur

--—-End
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Importing and Exporting APIs

5.1 Restrictions and Compatibility

Note the following restrictions and compatibility issues when importing or
exporting APIs on APIG:

Restrictions
e APIG parameter restrictions:

- APIG does not support the configuration of request parameters in the
formData and body locations.

- APIG does not support the configuration of parameters consumes and
produces.

- The names of header parameters are not case-sensitive.
e Backend policy restrictions are as follows:

-  Default backend type HTTP: The HTTP and HTTP-VPC backends are
supported.

- Default backend type HTTP-VPC: The HTTP and HTTP-VPC backends are
supported.

-  Default backend type function: Only the function backend is supported.
-  Default backend type mock: Only the mock backend is supported.

Compatibility
e Swagger 2.0 is supported.
e Mappings between imported or exported Swagger objects and APIG's objects.
e Differences in request parameter types
e Differences in API request path template syntax
e APIG supports the following extended fields when importing APlIs.
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Table 5-1 Mappings between Swagger objects and APIG's objects

Swagger APIG Import Export
Object Object
info.title APl group | Importing to a new API | API group name
name group: a new API group
name
Importing to an existing
API group: not used
An API group name
consists of 3-64
characters, starting with
a letter. Only letters,
digits, and underscores
(1) are allowed.
info.descript | APl group | Importing to a new API | API group description
ion description | group: description about
the new group
Importing to an existing
API group: not used
info.version | Version Not used User-defined version
The current time is used
as the API group name
if no name is specified.
host APl group | Not used The first user-defined
domain domain name of an API
name group is preferentially
used.
The independent
domain name of the API
group is used if the API
group is not bound with
any user-defined
domain names.
basePath - Merged with the Not used
request path of each
API
paths.path API Merged with basePath | API request path
request to use as an API request
path path
operation.o | APl name | APl name API name
perationid
operation.d | API API description API description
escription description
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Used together with x-
apigateway-auth-type

Swagger APIG Import Export
Object Object
operation.p | API API request parameters | APl request parameters
arameters frontend

request

parameters
operation.sc | API API request protocol API request protocol
hemes frontend

request

protocol
operation.re | - Not used Default response
sponses
operation.se | API API authentication API authentication
curity authentica | mode mode

tion mode

Used together with x-
apigateway-auth-type

Table 5-2 Differences in request parameter types

Swagger APIG Supported Attribute
integer number maximum
long minimum
float default
double enum
required
description
string string maxLength
minLength
default
enum
required
description
Other None None

Table 5-3 Differences in APl request path template syntax

Syntax

Swagger

APIG

Jusers/{userName}

Supported

Supported
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/users/prefix-{userName} -
suffix

Syntax Swagger APIG

Jusers/prefix-{userName} Supported Not supported for

Jusers/{userName}-suffix frontgnd request
definition

Supported for
backend request
definition

Jusers/{proxy+}

Not supported Supported for
frontend request
definition

Not supported for
backend request
definition

5.2 Extended Definition

5.2.1 x-apigateway-auth-type

Meaning: Swagger-based apiKey authentication format, which defines an
authentication mode provided by APIG.

Scope of effect: Security Scheme Object (2.0)

Swagger:

securityDefinitions:
apig-auth-app:

in: header

name: Authorization

type: apiKey

x-apigateway-auth-type: AppSigv1
apig-auth-iam:

in: header

name: unused

type: apiKey

x-apigateway-auth-type: IAM

Table 5-4 Parameter description

Parameter Man | Type
dator

y

Description

x-apigateway- | Yes String

Authentication mode used on APIG.

auth-type AppSigv1 and IAM are supported.

type Yes String Authentication type. Only apiKey is
supported.

name Yes String Name of the parameter for

authentication.
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Parameter Man | Type Description
dator
y
in Yes String Only header is supported.
description No String Description about the authentication.

5.2.2 x-apigateway-request-type
Meaning: API request type, which can be public or private.
Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:
x-apigateway-request-type: 'public'

Table 5-5 Parameter description

Parameter Man | Type Description

dator

y
X-apigateway- | Yes String API visibility. The options include
request-type public and private.

e public: The API can be made
available for sale.

e private: The API will not be
available for sale.

5.2.3 x-apigateway-match-mode
Meaning: Request URL matching mode, which can be NORMAL or SWA.
Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:
x-apigateway-match-mode: 'SWA'
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Table 5-6 Parameter description

Parameter Man | Type Description
dator
y
x-apigateway- | Yes String API matching mode. The options

match-mode

include SWA and NORMAL.

e SWA: prefix match. For example,
both /prefix/foo and /prefix/bar
match /prefix, but /prefixpart does
not match.

e NORMAL: exact match.

5.2.4 x-apigateway-cors

Meaning: Specifies whether CORS is supported. The value is of the Boolean type.

Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:
x-apigateway-cors: true

Table 5-7 Parameter description

cors

Parameter Man | Type Description
dator
y
x-apigateway- | Yes boolean Whether to support CORS.

e true: support
e false: not support

For the API request for enabling CORS, the headers listed in the following table
will be added to the response.

Header

Value

Description

Access-Control-Max-
Age

172800

Maximum time the
response of a preflight
request can be cached.

Unit: s

Access-Control-Allow-
Origin

Requests from any
domain are allowed.
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Header Value

Description

Access-Control-Allow- | X-Sdk-Date, X-Sdk-Nonce,
Headers X-Proxy-Signed-Headers, X-
Sdk-Content-Sha256, X-
Forwarded-For,
Authorization, Content-
Type, Accept, Accept-
Ranges, Cache-Control,

Headers that can be
used by a formal
request.

and Range
Access-Control-Allow- | GET, POST, PUT, DELETE,
Methods HEAD, OPTIONS, and
PATCH

Methods that can be
used by a formal
request.

5.2.5 x-apigateway-any-method

Meaning: API request method used by default if no HTTP request method is

specified.
Scope of effect: Path Item Object (2.0)

Example:

paths:
'/path':
get:
produces:
- application/json
responses:
"200":
description: "get response"
x-apigateway-any-method:
produces:
- application/json
responses:
"200":
description: "any response"

Table 5-8 Parameter description

Parameter Man | Type Description
dator
y
x-apigateway- | No String Request method.
any-method

5.2.6 x-apigateway-backend

5.2.6.1 x-apigateway-backend
Meaning: API backend definition.
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Scope of effect: Operation Object (2.0)

Example:

paths:
'/users/{userld}"
get:
produces:
- "application/json"
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "backend endpoint type"

Table 5-9 Parameter description

Parameter Mand | Type Description
atory
x-apigateway- | Yes String Backend service definition.
backend
type Yes String Backend service type. The options
include HTTP, HTTP-VPC, FUNCTION,
and MOCK.
parameters No X- Backend parameters.
apigateway-
backend.para
meters

httpEndpoints | No X-
apigateway-
backend.http
Endpoints

HTTP backend service definition.

httpVpcEndpo | No X-

ints apigateway-

backend.http
VpcEndpoint

HTTP VPC backend service definition.

backend.func
tionEndpoint

s
functionEndp | No X- Function backend service definition.
oints apigateway-

s
mockEndpoint | No X- Mock backend service definition.
s apigateway-

backend.moc

kEndpoints
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5.2.6.2 x-apigateway-backend.parameters

Meaning: API backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

parameters:

- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header'
required: true

- name: "userld"
description: "Username"
type: "string"
in: "path"
required: true

responses:

default:

description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:

type: "HTTP"

parameters:

- name: "userld"

value: "userld"

in: "query"

origin: "REQUEST"
description: "Username"
- name: "X-Invoke-User"

value: "apigateway"

in: "header'

origin: "CONSTANT"
description: "Caller'

Table 5-10 Parameter description

Parameter Man | Type Description
dator
y
name Yes String Parameter name, which consists of a
maximum of 32 bytes, starting with a
letter. Only letters, digits, periods (.),
hyphens (-), and underscores (_) are
allowed.
The names of header parameters are
not case-sensitive.
value Yes String Parameter value, which is a parameter
name if the parameter comes from a
request.
in Yes String Parameter location, which can be
header, query, or path.
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Parameter Man | Type Description
dator
y
origin Yes String Parameter mapping source. The
options include REQUEST and
CONSTANT.
description No String Parameter meaning.

5.2.6.3 x-apigateway-backend.httpEndpoints
Meaning: HTTP backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

parameters:

- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true

responses:

default:

description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:

type: "HTTP"

httpEndpoints:
address: "example.com"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

Table 5-11 Parameter description

Parameter Man | Type Description
dator
y
address Yes Array Backend service address. The format is
<Domain name or IP address>.[Port
number]
scheme Yes String Backend request protocol. HTTP and

HTTPS are supported.

method Yes String Backend request method. The options
include GET, POST, PUT, DELETE,
HEAD, OPTIONS, PATCH, and ANY.
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Parameter Man | Type Description
dator
y
path Yes String Backend request path, which can
contain variables.
timeout No Number Backend request timeout in
milliseconds. The range is 1-60,000,
and the default value is 5000.

5.2.6.4 x-apigateway-backend.httpVpcEndpoints

Meaning: HTTP VPC backend service definition.

Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

parameters:

- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true

responses:

default:

description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:

type: "HTTP-VPC"

httpVpcEndpoints:
name: "vpc-test-1"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

Table 5-12 Parameter description

Parameter Man | Type Description
dator
y
name Yes Array VPC channel name.
scheme Yes String Backend request protocol. HTTP and
HTTPS are supported.
method Yes String Backend request method. The options
include GET, POST, PUT, DELETE,
HEAD, OPTIONS, PATCH, and ANY.
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Parameter Man | Type Description
dator
y
path Yes String Backend request path, which can
contain variables.
timeout No Number Backend request timeout in
milliseconds. The range is 1-60,000,
and the default value is 5000.

5.2.6.5 x-apigateway-backend.functionEndpoints

Meaning: Function backend service definition.

Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "FUNCTION"
functionEndpoints:
version: "v1"
function-urn:
invocation-type: "synchronous"
timeout: 30000

nn

Table 5-13 Parameter description

Parameter Man | Type Description
dator
y
function-urn Yes String Function URN.
version Yes String Function version.
invocation- Yes String Function invocation type. The value
type can be async or sync.
timeout No Number Function timeout in milliseconds. The
range is 1-60,000, and the default
value is 5000.
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5.2.6.6 x-apigateway-backend.mockEndpoints
Meaning: Mock backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

parameters:

- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true

responses:

default:

description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:

type: "MOCK"

mockEndpoints:
result-content: "mocked"

Table 5-14 Parameter description

Parameter Man | Type Description
dator
y

result-content | Yes String Mock response.

5.2.7 x-apigateway-backend-policies

5.2.7.1 x-apigateway-backend-policies
Meaning: API backend policy.
Scope of effect: Operation Object (2.0)

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "backend endpoint type"
x-apigateway-backend-policies:
- type: "backend endpoint type"
name: "backend policy name"
conditions:
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- type: "equal/enum/pattern”,
value: "string",
origin: "source/request_parameter",
parameter_name: "string"

Table 5-15 Parameter description

policies.condi
tions

Parameter Man | Type Description
dator
y
x-apigateway- | No x-apigateway- | Backend policies.
backend- backend-
policies policies
type Yes String Backend service type. The options
include HTTP, HTTP-VPC, FUNCTION,
and MOCK.
name Yes String Backend policy name.
parameters No X- Backend parameters.
apigateway-
backend.para
meters
httpEndpoints | No X- HTTP service definition.
apigateway-
backend.http
Endpoints
httpVpcEndpo | No X- HTTP-VPC service definition.
ints apigateway-
backend.http
VpcEndpoints
functionEndp | No X- Function service definition.
oints apigateway-
backend.func
tionEndpoint
s
mockEndpoint | No X- Mock service definition.
s apigateway-
backend.moc
kEndpoints
conditions Yes X- Policy condition array.
apigateway-
backend-
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5.2.7.2 x-apigateway-backend-policies.conditions
Meaning: API backend policy conditions.
Scope of effect: x-apigateway-backend-policies

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

responses:

default:
description: "default response"

x-apigateway-request-type: "public"
x-apigateway-backend:

type: "backend endpoint type"

x-apigateway-backend-policies:

- type: "backend endpoint type"
name: "backend policy name"
conditions:

- type: "equal/enum/pattern”,
value: "string",
origin: "source/request_parameter",
parameter_name: "string"

Table 5-16 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Policy condition type. The options

include equal, enum, and pattern.

value Yes String Policy condition value.

origin Yes String Policy condition source. The options
include source and request.

parameter No String Input parameter name if the origin

parameter is set to request.

5.2.8 x-apigateway-ratelimit

Meaning: Request throttling policy.

Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:

x-apigateway-ratelimit: 'customRatelimitName'
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Table 5-17 Parameter description

Parameter Mand | Type Description

atory
x-apigateway- | No String Request throttling policy.
ratelimit

5.2.9 x-apigateway-ratelimits

5.2.9.1 x-apigateway-ratelimits
Meaning: Mapping between a request throttling policy name and limit values.
Scope of effect: Swagger Object

Example:

x-apigateway-ratelimits:
customRatelimitName:
api-limit: 200
app-limit: 200
user-limit: 200
ip-limit: 200
interval: 1
unit: second/minute/hour
shared: true
special:
- type: APP
limit: 100
instance: XXXXXXXXX

Table 5-18 Parameter description

Parameter Mand | Type Description
atory
customRateli | No X- Name of a request throttling policy.
mitName apigateway- | 14 yse the policy, set x-apigateway-
ratelimits.pol | ratelimit to the policy name.
icy

5.2.9.2 x-apigateway-ratelimits.policy
Meaning: Definition of a request throttling policy.
Scope of effect: x-apigateway-ratelimits

Example:

x-apigateway-ratelimits:
customRatelimitName:
api-limit: 200
app-limit: 200
user-limit: 200
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ip-limit: 200
interval: 1
unit: MINUTE
shared: false
special:
- type: USER
limit: 100
instance: XxXxxxxx

Table 5-19 Parameter description

Parameter Man | Type Description
dator
y
api-limit Yes Number Maximum number of times an APl can
be called.
user-limit No Number Maximum number of times the API
can be called by a user.
app-limit No Number Maximum number of times the API
can be called by an app.
ip-limit No Number Maximum number of times the API
can be called by an IP address.
interval Yes Number Throttling period.
unit Yes String Throttling unit, which can be SECOND,
MINUTE, HOUR, or DAY.
shared No Boolean Whether to share the throttling limits
among APIs.
special No X- Special request throttling policy.
apigateway-
ratelimits.pol
icy.special
Array

5.2.9.3 x-apigateway-ratelimits.policy.special

Meaning: Definition of a special request throttling policy.

Scope of effect: x-apigateway-ratelimits.policy

Example:

x-apigateway-ratelimits:
customRatelimitName:

api-limit: 200
app-limit: 200
user-limit: 200
ip-limit: 200
interval: 1
unit: MINUTE
shared: false
special:
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- type: USER
limit: 100
instance: XXXXXxxx

Table 5-20 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Special request throttling policy type,
which can be APP or USER.
limit Yes Number Access limit.
instance Yes String ID of an excluded app or user.

5.2.10 x-apigateway-access-control
Meaning: Access control policy.
Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:
x-apigateway-access-control: 'customAccessControlName'

Table 5-21 Parameter description

Parameter Man | Type Description

dator

y
x-apigateway- | No String Access control policy.
access-control

5.2.11 x-apigateway-access-controls

5.2.11.1 x-apigateway-access-controls

Meaning: Mapping between an access control policy name and limit settings.
Scope of effect: Swagger Object

Example:

x-apigateway-access-controls:
customAccessControlName:
acl-type: "DENY"
entity-type: "IP"
value: 127.0.0.1,192.168.0.1/16
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Table 5-22 Parameter description

Parameter Man | Type Description
dator
y
customAccess | No X- Name of an access control policy.
ControlName apigateway- | 14 yse the policy, set x-apigateway-
access- | access-control to the policy name.
controls.polic
y

5.2.11.2 x-apigateway-access-controls.policy

Meaning: Definition of an access control policy.
Scope of effect: x-apigateway-access-controls

Example:

x-apigateway-access-controls:
customAccessControlName:
acl-type: "DENY"
entity-type: "IP"
value: 127.0.0.1,192.168.0.1/16

Table 5-23 Parameter description

Parameter Man | Type Description
dator
y
acl-type Yes String Access control effect. The options

include PERMIT and DENY.

entity-type Yes String Access control object. Only IP
addresses are supported.

value Yes String Access control values, which are
separated with commas (,).

5.2.12 x-apigateway-plugins

Meaning: API plug-in service.
Scope of effect: Operation Object (2.0)

Example:

paths:
'/path":
get:
x-apigateway-plugins: ['Plugin_mock']
x-apigateway-plugins
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Table 5-24 Parameter description

Parameter Man | Type Description

dator

y
x-apigateway- | No Array List of plug-ins bound to the API.
plugins

5.3 API Import Precautions

You can import Swagger APIs to a new or existing API group on APIG. Before
importing APIs, complete the extended definition of APIG.

Importing APIs to a New API Group

When you import APIs to a new API group, the system creates an API group.

This function is suitable for importing new APIs to APIG.

Before importing APIs, ensure that the following requirements are met:

Your API group and API quotas are sufficient.

Use the title property in Swagger info to specify an APl group name. The
name of a new API group cannot be the same as that of an existing one.

If two APIs have the same definition (such as the same name or request
path), only the first APl will be imported.

If Extended Definition Overwrite is selected, the extended definition items
(access control and request throttling policies) of an imported API will
overwrite the existing extended definition items with the same name.

Imported APIs will not be automatically published in an environment. You can
choose to publish them immediately or later.

Importing APIs to an Existing API Group

When you import APIs to a specified APl group, the system adds them to the API
group while retaining the existing APIs.

This function is suitable for importing new or modified APIs to an existing API
group.

Before importing APIs, ensure that the following requirements are met:

Your API quota is sufficient.

If the definition of an API you are importing is the same as that of an existing
API, you can overwrite the existing API or retain it. If you leave the existing
API alone, the new API will not be imported.

If Extended Definition Overwrite is selected, the extended definition items
(access control and request throttling policies) of an imported API will
overwrite the existing extended definition items with the same name.

Imported APIs will not be automatically published in an environment. You can
choose to publish them immediately or later.
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5.4 Examples of Importing APIs

5.4.1 Importing an HTTP Backend Service API

Import the request parameter definition of an HTTP backend service API that uses
the GET method and is accessed through IAM authentication.

Swagger example:

swagger: "2.0"
info:
title: "importHttpEndpoint10"
description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/http/{userld}":
get:
operationld: "getUser3"

description: "get user by userld"

security:

- apig-auth-iam: []
schemes:

- https
parameters:

- hame: "test"

description: "authorization token"

type: "string"
in: "header"
required: true
- name: "userld"
description: "user id"
type: "string"
in: "path"
required: true
responses:
"200":

description: "user information"
x-apigateway-request-type: "public"

x-apigateway-cors: true

x-apigateway-match-mode: "NORMAL"

x-apigateway-backend:
type: "HTTP"
parameters:

- name: "userld"
value: "userld"
in: "query"
origin: "REQUEST"
description: "user id"

- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"

httpEndpoints:
address: "example.com"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

securityDefinitions:
apig-auth-app:
in: header
name: Authorization
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type: apiKey

x-apigateway-auth-type: AppSigv1
apig-auth-iam:

in: header

name: unused

type: apiKey

x-apigateway-auth-type: IAM

5.4.2 Importing an HTTP VPC Backend Service API

Import the request parameter definition of an HTTP VPC backend service API that
uses the ANY method and is accessed through app authentication.

Swagger example:

swagger: "2.0"
info:
title: "importHttpVpcEndpoint"
description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/http-vpc":
x-apigateway-any-method:
operationld: "userOperation"
description: "user operation resource"
security:

- apig-auth-app: []

schemes:

- https

parameters:

- name: "Authorization"
description: "authorization signature
type: "string"
in: "header"
required: true

responses:

"default":
description: "endpoint response"
x-apigateway-request-type: "public"
x-apigateway-cors: true
x-apigateway-match-mode: "SWA"
x-apigateway-backend:
type: "HTTP-VPC"
parameters:
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"
httpVpcEndpoints:
name: "userVpc"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000
securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM

n
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5.4.3 Importing a Function Backend Service API

Import the request parameter definition of a FunctionGraph backend service API
that uses the GET method and is accessed through IAM authentication.

Swagger example:

swagger: "2.0"
info:
title: "importFunctionEndpoint"
description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/function/{name}"
get:
operationld: "invokeFunction"

description: "invoke function by name"

security:
- apig-auth-iam: []
schemes:
- https
parameters:
- name: "test"
description: "authorization token"
type: "string"
in: "header"
required: true
- name: "name"
description: "function name"
type: "string"
in: "path"
required: true
responses:
"200":
description: "function result"
x-apigateway-request-type: "public"
x-apigateway-cors: true

x-apigateway-match-mode: "NORMAL"

x-apigateway-backend:
type: "FUNCTION"
parameters:
- name: "functionName"
value: "name"
in: "query"
origin: "REQUEST"
description: "funtion name"
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"
functionEndpoints:

function-urn: "your function urn address"

version: "your function version"
invocation-type: "async"
timeout: 30000
securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM
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5.4.4 Importing a Mock Backend Service API

Import the definition of a Mock backend service API that uses the GET method

and is accessed without authentication.

Swagger example:

swagger: "2.0"
info:
title: "importMockEndpoint"
description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/mock":
get:
operationld: "mock"
description: "mock test"
schemes:
- http
responses:
"200":
description: "mock result"
x-apigateway-request-type: "private"
x-apigateway-cors: true
x-apigateway-match-mode: "NORMAL"
x-apigateway-backend:
type: "MOCK"
mockEndpoints:
result-content: "{\"message\": \"mocked\"}"
securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM

5.5 API Export Precautions

Save the definition of an APl on APIG as a Swagger file, and export it in YAML or
JSON format. You can export the basic, full, or extended definitions of APIs.

Exporting the Basic Definition of an API

The basic definition of an APl is composed of the request and response definitions
and does not include the backend definition. The request definition includes both

standard and extended Swagger fields.

This function can generate a Swagger definition file.

Exporting the Full Definition of an API

The full definition of an API is composed of the request, backend, and response

definitions.

This function can be used to back up the full definition of an API as a Swagger

file.
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Exporting the Extended Definition of an API

The extended definition of an APl is composed of the request, backend, and
response definitions as well as the request throttling policy, access control policy,
and other configurations of the API.
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Change History

Table 6-1 Change history

Date Description
2022-12-30 This issue incorporates the following changes:
e Optimized API Import Precautions.
e Optimized API Export Precautions.
2020-12-10 This issue is the first official release.
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